Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it’s our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. *If there’s no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)*
BlackStorm Video Server · User Guide

• Ross Part Number: **3150DR-002-1.3**
• Release Date: April 28, 2014. Printed in Canada.
• Software Issue: **1.3**

The information contained in this Guide is subject to change without notice or obligation.

Copyright

© 2014 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents

Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 7,914,332; 8307284, 2039277; 1237518; 1127289 and other patents pending.

Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, read all the Important Safety Instructions listed below so as to avoid personal injury and to prevent product damage.

The BlackStorm system makes use of a number of individual component products to make up a complete turnkey system. The Important Safety Instructions section of this manual is intended to compliment individual OEM product manuals and the User must refer to, and heed, any safety instruction outline in these supplementary product manuals.

This system may also require specific equipment, and /or installation procedures be carried out to satisfy certain other regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.
Symbol Meanings

**Protective Earth** — This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.

**Warning** — The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

**Caution** — The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

**Warning Hazardous Voltages** — This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.

**ESD Susceptibility** — This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.

**Important Safety Instructions**

- Read these instructions.
- Keep these instructions.
- Heed all warnings.
- Follow all instructions.

**Warning**

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.
8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit in to your outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
11) Only use attachments/accessories specified by the manufacturer.
12) Unplug this apparatus during lightning storms or when unused for long periods of time.
13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug damage, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
14) Do not expose this apparatus to dripping or splashing and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.
15) To completely disconnect this apparatus from the AC Mains, disconnect all power supply cord plugs from the AC receptacles.
16) The mains plug of the power supply cords shall remain readily operable.
17) The BlackStorm Server chassis is to be rack mounted only. To ensure safe operation and maintain long-term system reliability, proper installation requires that the front and back area of the chassis are clear from obstructions so as not to restrict airflow.
18) Indoor Use: WARNING: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.
19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.
20) WARNING: This apparatus when equipped with multiple power supplies can generate high leakage currents. To reduce the risk of electric shock ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.
21) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.
22) CAUTION: This apparatus contains a Lithium battery, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type recommended by the manufacturer. Dispose of used batteries according to the manufacturer's instruction by qualified service personnel.
23) Certain parts of this equipment still present a safety hazard, with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.
24) This product contains safety critical parts, which if incorrectly replaced may present a risk of fire or electrical shock. Components contained within the product's power supplies and power supply area, are not intended to be customer serviced and should be returned to the factory for repair.
25) To reduce the risk of fire, replacement fuses must be the same type and rating.
26) Use only power cords specified for this product and certified for the country of use. Refer to the Product Power Cord Requirement Section that follows.
27) The Safe operation of this equipment requires that the User heed and adhere to all installation and servicing instruction contained within the equipment's Engineering Manuals.
EMC Notices

US FCC Part 15
This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Notice Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user’s authority to operate this equipment.

CANADA
This Class “A” digital apparatus complies with Canadian ICES-003.
Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE
This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

INTERNATIONAL
This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002 and found to comply with the limits for a Class A Digital device.

Notice This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its BlackStorm Server systems to be free from defects under normal use and service for the following time periods from the date of shipment:

- BlackStorm Server — 12 months
- BlackStorm Server Software Upgrades — 12 months free of charge
- System and Media hard drives — 36 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.
Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information about an extended warranty for your BlackStorm Server system, contact your regional sales manager.

Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Company Address

<table>
<thead>
<tr>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
</tr>
<tr>
<td>Iroquois, Ontario</td>
<td>Ogdensburg, New York</td>
</tr>
<tr>
<td>Canada, K0E 1K0</td>
<td>USA 13669-0880</td>
</tr>
</tbody>
</table>

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
Contents

Introduction ................................................................................................................................. 1
  About This Guide ....................................................................................................................... 1-1
  Documentation Conventions ................................................................................................. 1-2
  Getting Help ......................................................................................................................... 1-2

Software Installation .................................................................................................................. 2
  BlackStorm Client Usage ....................................................................................................... 2-2
  System Requirements ........................................................................................................... 2-2
  Client Software Installation ................................................................................................. 2-3
  Client Software Update ....................................................................................................... 2-9
  BlackStorm Server Software Update .................................................................................. 2-11
  BlackStorm Server Software Uninstall .............................................................................. 2-18
  BlackStorm Server Services ............................................................................................... 2-19

Server Configuration .................................................................................................................... 3
  Logging on to the Server ....................................................................................................... 3-2
  Network Connections ........................................................................................................... 3-2
  Server Performance ............................................................................................................. 3-4
  Firewall Configuration ......................................................................................................... 3-4
  Client Configuration ............................................................................................................ 3-5
  Channel Name Configuration .............................................................................................. 3-8
  GenLock Configuration ........................................................................................................ 3-8
  Remote Control Configuration ............................................................................................. 3-10
  House Time Configuration ................................................................................................. 3-12
  Channel Time Configuration ............................................................................................... 3-13

BlackStorm Client Layout .......................................................................................................... 4
  Connecting to a BlackStorm Server ..................................................................................... 4-2
  Accessing BlackStorm Clients in Dashboard ...................................................................... 4-2
  Creating a BlackStorm Client Layout .................................................................................. 4-3
  Additional DashBoard Windows for BlackStorm Clients ..................................................... 4-10
  Saving and Recalling BlackStorm Client Layouts ............................................................... 4-10

Adding Media Items to a BlackStorm Server ............................................................................ 5
  Targa File Resolution .......................................................................................................... 5-2
  Loading Media Files through the Media Manager ................................................................. 5-2
  Using the Drop Folder to Load Media Files ......................................................................... 5-6
  Importing Media Files from Selected Folders ...................................................................... 5-7
  Managing Media Items ........................................................................................................ 5-9

Playing Media Items from a BlackStorm Server .................................................................... 6
  Playing Media Items ............................................................................................................. 6-2
  Working with Media Item Buckets ...................................................................................... 6-7
  Custom Media Item Playout ................................................................................................. 6-12
  Viewing Multiple Timecodes in One Place .......................................................................... 6-16
## Contents

- **Working with Playlists**
  - Creating Playlists ................................................................. 7-2
  - Editing Playlists ........................................................................ 7-5
  - Playing Out Playlists ............................................................... 7-10

- **Coloring BlackStorm Clients**
  - Client Background and Text Colors ....................................... 8-2
  - Customizing Colors ................................................................ 8-2

- **Appendix A. Specifications**
  - Media Formats and Codecs .................................................... 9-2
  - VDCP Commands for the BlackStorm Server .......................... 9-3
  - AMP Commands for the BlackStorm Server ............................ 9-4
  - Communication Serial Port .................................................... 9-5

- **Appendix B. Configuration File Settings**
  - Editing Configuration Files .................................................... 10-2
  - Client Settings Set by Editing a Configuration File .................. 10-2
  - Server Settings Set by Editing Configuration Files ................. 10-3
  - Crispin NewsCat Settings ....................................................... 10-5
  - Horizontal and Vertical Video Offset Settings ......................... 10-6

- **Index** ..................................................................................... IX
Introduction

Thank you for choosing a Ross Video BlackStorm Server.

Ross Video designed the BlackStorm product line with the needs of live production in mind. The BlackStorm Server is an easy to use, yet powerful, production video server. The BlackStorm Server supports file-based workflows to enable easy networked integration of media items from non-linear editing systems and graphics packages. The Configuration, Media Manager, Play, and Playlist clients contain a wide range of features to configure and control a BlackStorm Server. BlackStorm uses the VDCP protocol to interface with a wide variety of production switchers, controllers and automation systems.

The user interface of the BlackStorm Server and clients support the UTF-8 character set to enable the entry and display of international characters for channel, media item, playlist, and bucket names.

We appreciate your business and sincerely hope that you have a great experience with your new BlackStorm Server. As always, if there is anything that we at Ross Video can do to assist you, please do not hesitate to contact us.

About This Guide

This guide covers the use of the BlackStorm Video Server. This guide includes the following chapters:

- Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature descriptions.
- Chapter 2, “Software Installation” provides instructions for installing BlackStorm Client software on a separate computer to remotely access the BlackStorm Server.
- Chapter 3, “Server Configuration” provides instructions for using the Configuration Client to configure BlackStorm Server communication, inputs, and outputs.
- Chapter 4, “BlackStorm Client Layout” provides instructions for creating and saving custom BlackStorm Client application layouts to match your workflow.
- Chapter 5, “Adding Media Items to a BlackStorm Server” provides instructions for using the watch folders to add media items to a BlackStorm Server.
- Chapter 6, “Playing Media Items from a BlackStorm Server” provides instructions for using the Play Client to play media items from a BlackStorm Server.
- Chapter 7, “Working with Playlists” provides instructions for creating and playing out selections of custom-ordered media items.
- Chapter 8, “Coloring BlackStorm Clients” provides instructions for changing the background and the text color for Media Manager, Play, and Playlist Clients.
- Appendix A, “Appendix A. Specifications” describes the basic properties of your BlackStorm Server, including specifications and capabilities.
- An Index for reference.

If you have questions pertaining to the operation of the BlackStorm Video Server, please contact us at the numbers listed in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for consultation, training, or service.
Documentation Conventions

This guide uses special text formats to identify parts of the user interface, text that a user must enter, or a sequence of menus and submenus that to follow to reach a particular command.

Interface Elements

Bold text identifies a user interface element such as a dialog box, a menu item, or a button. For example:

In the **Media Manager**, click **Channel 1** in the **Channels** section.

User Entered Text

Courier text identifies text that a user must enter. For example:

In the **File Name** box, enter `Channel01.property`.

Referenced Guides

Italic text identifies the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “**GenLock Configuration**” on page 3–8 in the *BlackStorm User Guide*.

Menu Sequences

In a procedure menu arrows identify a sequence of menu items that you must follow. For example, if a step reads “**Server** > **Save As**,“ you would click the **Server** menu and then click **Save As**.

Important Instructions

Star icons identify important instructions or features. For example:

★ When the Media Manager cannot connect to the BlackStorm Server, a **Message** dialog box opens to report the connection problem.

Getting Help

To access the BlackStorm Server Online Help system, select **Help Topics** from the **Help** menu in a BlackStorm Client. Alternatively, press the **F1** key while working in a BlackStorm client or a dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help topics and *User Guide*:

- **Contents** — table of contents
- **Index** — keyword reference
- **Search** — full text search
- **Favorites** — preferred information storage and access

The BlackStorm Server Software Installation DVD includes BlackStorm Server guides in the format of print-ready PDF files.
Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone. Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. Ross Video personnel directly provide after-sales service and technical support. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, please leave a voice message for a return call. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support:** (+1) 613-652-4886
- **After Hours Emergency:** (+1) 613-349-0006
- **E-mail:** techsupport@rossvideo.com
- **Website:** http://www.rossvideo.com
Software Installation

This chapter includes procedures for installing and uninstalling BlackStorm Client software on computers that remotely access a BlackStorm Server; as well as, installing and uninstalling BlackStorm Server software on a BlackStorm Server computer.

This chapter discusses the following topics:

• BlackStorm Client Usage
• System Requirements
• Client Software Installation
• BlackStorm Server Software Update
• BlackStorm Server Software Uninstall
• BlackStorm Server Services
BlackStorm Client Usage

The BlackStorm Server can be controlled by BlackStorm Clients installed in the following locations:

- On remote computers connected to the BlackStorm Server by a Local Area network.
- Directly on the BlackStorm Server

Working from a Remote Computer

To access a BlackStorm Server from a remote computer connected to the same Local Area network as the server, start by installing Ross Video DashBoard and BlackStorm Client software on the remote computer. BlackStorm Client software includes the following applications:

- Configuration Client
- Media Manager
- Play Client
- Playlist Client
- Timecode Client

Before you install BlackStorm Client software on a computer, verify that the computer meets the following requirements:

- The remote computer must meet the list of system requirements in the section “System Requirements” on page 2–2.
- Folders must be shareable over the network with the BlackStorm Server. Refer to the section “Firewall Configuration” on page 3–4 for further information on sharing folders over the network.

For More Information on...

- BlackStorm Clients, refer to the following sections:
  - “Server Configuration” on page 3–1
  - “Adding Media Items to a BlackStorm Server” on page 5–1
  - “Playing Media Items from a BlackStorm Server” on page 6–1
  - “Working with Playlists” on page 7–1

Working Directly from the BlackStorm Server

If required, connect a monitor, keyboard, and mouse to the USB ports on the back or front of the BlackStorm Server to use the installed BlackStorm Client software on the BlackStorm Server. Refer to the Cabling Your BlackStorm Server Quick Start Guide for further information on the rear peripheral connections of the BlackStorm Server.

System Requirements

To ensure that BlackStorm Client software functions correctly, verify that the selected computer to install BlackStorm Client software on meets the requirements described in the following sections.

Hardware

Ross Video recommends the following minimum computer hardware configuration to run BlackStorm Client software:

- Intel® Pentium 4, 1.6 GHz (Intel® Core™ 2 Duo recommended)
- 1 GB or more of RAM (2GB recommended)
- 450 MB free disk space
Software

Ross Video recommends the following minimum computer software configuration to run BlackStorm Client software:

- Ross Video DashBoard 6.0.0 or higher
- Microsoft® Windows® XP Professional or Microsoft® Windows® 7
- Microsoft® Internet Explorer® version 5 (minimum)

* Install all of the operating system updates, the necessary security patches, and the available service packs on the remote computer before installing BlackStorm Client software on the computer.

Client Software Installation

To access a BlackStorm Server, a remote computer requires connectivity to the BlackStorm Server and the following installed software:

- **DashBoard™ Control System** — the BlackStorm Server Software DVD shipped with the BlackStorm Server contains the DashBoard application installer. The installer is also downloadable from the Ross Video website. When installing DashBoard for the sole purpose of controlling a BlackStorm Server, complete the following recommended component selections on the Choose Components screen of the DashBoard application installer:
  - Select the DashBoard Framework box.
  - Clear the openGear Control box.
  - Clear the Router Control box.

- **BlackStorm Clients** — install Client software in DashBoard from a BlackStorm Server.

For More Information on...

- DashBoard application installation or uninstall, refer to the DashBoard Control System User Manual and the DashBoard Online Help system.
- DashBoard plug-ins updates, refer to the DashBoard Control System User Manual and the DashBoard Online Help system.
- where to download the Dashboard application installer, refer to the Terminal Equipment | openGear | Control & Monitoring | DashBoard section of the Ross Video website.
DashBoard Configuration for BlackStorm Clients

Before you install BlackStorm Clients in Dashboard, you must properly configure the DashBoard application on the remote computer.

To configure DashBoard for BlackStorm Clients:

1. On the Client computer, verify that the following conditions are true:
   - The remote computer uses the current version of DashBoard software.
   - The Client computer can access a running BlackStorm Server on the network.

2. Use one of the following methods to launch DashBoard:
   - Double-click the DashBoard icon on the desktop.
   - Use the Start menu to select All Programs > DashBoard > DashBoard.

   DashBoard opens.

3. Use the Window menu to select Preferences.

   The Preferences dialog box opens.
4. In the tree view, select **Automatic Discovery**.

The **Automatic Discovery** panel opens.

5. In the **Automatic Discovery of Devices** section, select the **Disable** option.

6. In the tree view, expand the **Install/Update** node and select **Available Software Sites**.

The **Available Software Sites** panel opens.
7. Clear all of the check boxes in the Name column.
8. Click Add.

The Add Site dialog box opens

![Add Site Dialog Box](image)

9. In the Name box enter a name to describe the software site.
10. In the Location box, enter the IP address or hostname of the BlackStorm Server with the following suffix:

    :8080/Plugin/BlackStorm

    Your Network Administrator can provide you with the IP address of your BlackStorm Server.

    To use a BlackStorm Server with the IP address of 192.168.1.1 as a software download site for BlackStorm Client software, enter the following URL in the Location box:

    • http://192.168.1.1:8080/Plugin/BlackStorm

11. Click OK.

    The Add Site dialog box closes and the list of available software sites displays the new software site.

12. Select the check box to the left of the new software site if it is clear.
13. Click OK.

    The Preferences dialog box closes after saving the set preferences.
14. Use the File menu to select New > Manual Connection.

The Manually Detect Device dialog box opens.

15. In the IP Address box, enter the IP address of the BlackStorm Server. This IP address is the same as the IP address entered in the Add Site dialog box (step 10 on page 2-6).

16. Click Detect Settings.

The Attribute and Value columns display information about the selected BlackStorm Server.

When BlackStorm Server settings go undetected, use one of the following methods to restart the BlackStormHttpService:

- On the BlackStorm Server, use the Services tab in the Windows Task Manager to restart the BlackStormHttpService.
- Restart the BlackStorm Server.

17. Click Finish.

The DashBoard Tree View displays a node for the added BlackStorm Server.
Installing BlackStorm Clients

With DashBoard now configured, use the BlackStorm Server displayed in the DashBoard Tree View to install BlackStorm Client software.

To install BlackStorm Client software in DashBoard on a client computer:

1. On the Client computer, verify that the following conditions are true:
   - The remote computer uses the current version of DashBoard software.
   - DashBoard software properly configured to access a BlackStorm Server.
   - The Client computer can access a running BlackStorm Server on the network.

2. In the DashBoard Tree View, double-click the BlackStorm Server node from which to install BlackStorm Client software.

   The Install Software dialog box opens.

3. In the Install column, select the check box for BlackStorm Video Server if it is clear.
4. Click **Install**.
   A progress bar displays the installation status. After the installer finishes installing the required files, the **Restart Dashboard** dialog box opens.

5. Click **Yes**.
   The Dashboard restarts to complete the installation of BlackStorm Client software.

6. Manually add the BlackStorm Server to Dashboard by following step 14 on page 2-7 to step 17 on page 2-7 in the **To configure Dashboard for BlackStorm Clients** procedure.
   The Dashboard **Tree View** displays a node for the new BlackStorm Server.

7. Hover the mouse over the **BlackStorm Server** node to view the following information about the BlackStorm Server:
   - IP address
   - Installed software version
   - Client to Server connection status

8. Expand the **BlackStorm Server** node to access the BlackStorm Clients.

   **Client Software Update**

   After updating the software on a BlackStorm Server, you should also update the BlackStorm Client software on Client computers to make use of the new features of the updated BlackStorm Server.
To update BlackStorm Client software on a computer:

1. Use the **Help** menu in **DashBoard**, to select **Check for Updates**.
   The **Available Updates** wizard opens.

2. In the **Name** column of the **Available Updates** screen, select the **BlackStorm Video Server** check box if it is clear.
   It is optional to select any additional updates listed with the **BlackStorm Video Server** update. To skip over the installation of an update, clear the associated check box in the **Name** column.

3. Click **Next**.
   The **Update Details** screen opens.
4. Click Next.

The **Review Licenses** screen opens.

![Review Licenses screen](image1.png)

5. Select the **I accept the terms of the license agreement** option.

6. Click **Finish**.

A progress bar displays the installation status **BlackStorm Client software update**.

![Updating Software progress bar](image2.png)

After the installer finishes installing the required files, the **Software Updates** dialog box opens.

![Software Updates dialog box](image3.png)

7. Click **Yes**.

DashBoard restarts to complete the update of BlackStorm Client software.

**BlackStorm Server Software Update**

- After each new release of BlackStorm Server software, you should update existing BlackStorm Servers with the newly released BlackStorm Server software. BlackStorm Server software updates are downloadable from the Ross Video website.
The upgrade processes for the various models of BlackStorm Server to BlackStorm software version 1.3 are as follows:

- 2 Channel BlackStorm Server
  - “BlackStorm Version 1.3 Software Update” on page 2–12
  - “AJA Corvid 22 Card Firmware Update” on page 2–14

- 4 Channel BlackStorm Server
  - “BlackStorm Version 1.3 Software Update” on page 2–12
  - “AJA Corvid 24 Card Firmware Update” on page 2–16

**BlackStorm Version 1.3 Software Update**

To update BlackStorm Server software to version 1.3:

1. Use the following credentials to log on to the BlackStorm Server computer:
   - **User name** — blackstorm
   - **Password** — blackstorm

2. Shut down all Windows applications.

3. Right-click the BlackStorm Service Manager icon in the System Tray and select Exit to exit the BlackStorm Service Manager.

   The BlackStorm Service Manager closes and the icon leaves from the System Tray.

4. Download the BlackStorm Version 1.3.zip file from Ross Video.

5. Unzip the BlackStorm Version 1.3.zip file to the desktop.

6. On the desktop, open the BlackStorm Version 1.3 folder.

7. Double-click BlackStorm-Installer-1.3.#.###.exe.

   The BlackStorm-1.3.#.### Setup wizard opens.
8. Click **Install** to begin updating BlackStorm Server software.
   The **Installing** screen opens to display the progress of the software installation.

![Installing screen](image)

During the installation, multiple run to install the various components of the BlackStorm Server. After the installer finishes installing the required files, the **Completing the BlackStorm-1.3.#.#### Setup Wizard** screen opens.

![Completing the Setup Wizard](image)

9. Select the **Reboot now** option
10. Click **Finish**.
   The BlackStorm Server computer restarts to complete the installation of the BlackStorm Server software.
AJA Corvid 22 Card Firmware Update

To check the firmware version of the AJA Corvid 22 card in a BlackStorm Server:

1. On the BlackStorm Server computer, start the following application:
   - `C:\ProgramFiles(x86)\AJA\Xena\SDK\DiagnosticsAndTools\XenaControlPanel`
   
   The XenaControlPanel icon opens to the System Tray.

2. In the System Tray, click the XenaControlPanel icon and select About from the menu.
   
   The About tab opens in the Control Panel for Corvid22 dialog box.

3. Check the firmware version displayed in the PCI FPGA Version field.

4. Depending on the version of the installed firmware, continue the BlackStorm Server software upgrade with one of the following procedures:
   - If the firmware version is NOT D, continue with the procedure “To update an AJA Corvid 22 card to firmware version 13:” on page 2–14.
   - If the firmware version is D, the AJA Corvid 22 card does not require a firmware update.

5. Close the Control Panel for Corvid22 dialog box.

To update an AJA Corvid 22 card to firmware version 13:

1. On the BlackStorm Server computer, open the `C:\ross\BlackStorm\AJADrivers` folder.

2. Unzip the `corvid22firmware_13.zip` file to the desktop.

3. On the desktop, open the `corvid22firmware_13` folder.
   The **PCI Bitfile Burner** dialog box opens.

![PCI Bitfile Burner dialog box](image1)

5. Double-click in the **Update To PCI Bitfile** box.
   The **Open Video File** dialog box opens.

![Open Video File dialog box](image2)

6. Select the `top_c22_13.bit` file from the **Bit Files** list.
7. Click **OK**.
   The **Open Video File** dialog box closes. In the **PCI Bitfile Burner** dialog box and the **Update To PCI Bitfile** box displays `Corvid22_13.bit` and the **Status** box displays **Ready**.

8. Click **Start**.
   After the installer finishes installing the firmware, the **Reboot** dialog box opens.

9. Click **OK**.
   The BlackStorm computer reboots to complete the installation of the AJA Corvid 22 card firmware.
AJA Corvid 24 Card Firmware Update

To check the firmware version of the AJA Corvid 24 card in a BlackStorm Server:

1. On the BlackStorm Server computer, use the Start menu to select All Programs > AJA > Watcher.
   
The AJA OEM Card Watcher dialog box opens.

2. Click the Info tab.
   
The Info tab opens.

3. Check the firmware version displayed in the PCI FPGA Version field.

4. Depending on the version of the installed firmware, continue the BlackStorm Server software upgrade with one of the following procedures:
   
   • If the firmware version is NOT 4, continue with the procedure “To update an AJA Corvid 24 card to firmware version 4:” on page 2–17.
   
   • If the firmware version is 4, the AJA Corvid 24 card does not require a firmware update.

5. Close the AJA OEM Card Watcher dialog box.
To update an AJA Corvid 24 card to firmware version 4:

1. On the BlackStorm Server computer, open the C:\ross\BlackStorm\AJADrivers folder.
2. Unzip the corvid24firmware_11-19-12 Ver. 4 - Released 19 Nov 2012.zip file to the desktop.
3. On the desktop, open the corvid24firmware_11-19-12 Ver. 4 - Released 19 Nov 2012 folder.

   The PCI Bitfile Burner dialog box opens.

5. Double-click in the Update To PCI Bitfile box.

   The Open Video File dialog box opens.

6. Select the corvid24quad_11-19-12.bit file from the Bit Files list.
7. Click OK.

   The Open Video File dialog box closes. In the PCI Bitfile Burner dialog box and the Update To PCI Bitfile box displays corvid24_quad.ncd 2012/11/19 09:29:54 and the Status box displays Ready.
8. Click Start.

After the installer finishes installing the firmware, the Power Off dialog box opens.

9. Click OK.

The BlackStorm computer reboots to complete the installation of the AJA Corvid 24 card firmware.

BlackStorm Server Software Uninstall

The BlackStorm Uninstall Wizard removes BlackStorm Server software from a server computer.

To uninstall BlackStorm Server software from the server computer:

1. Use the following credentials to log on to the BlackStorm Server computer:
   - User name — blackstorm
   - Password — blackstorm

2. From the Start Menu, select All Programs > BlackStorm > Uninstall.

   The BlackStorm-1.3.#.#### Uninstall wizard opens.

3. Click Next.

   The Uninstall BlackStorm-1.3.#.#### screen opens.
4. Click **Uninstall** to begin uninstalling BlackStorm Server software.

The **Uninstalling** screen opens to display the progress of the software removal.

After the BlackStorm-1.3.#.#### Uninstall wizard has removed the required files, the **Completing the BlackStorm-1.3.#.#### Uninstall** screens opens.

5. Select the **Reboot now** option

6. Click **Finish**.

The BlackStorm Server computer restarts to complete the removal of BlackStorm software from the server computer.

**BlackStorm Server Services**

The following services run on the BlackStorm Server computer to enable the BlackStorm Server to playout and to catalog media items:

- **BlackStorm Server** — plays out media items from the BlackStorm Server.
- **Database** — catalogs media items in the BlackStorm Server Media database.
- **Service Location Protocol** (SLP) — locates BlackStorm Servers on the local network.
The BlackStorm Server icon in the System Tray reports the status of BlackStorm Server services. You can also use the icon to control BlackStorm Server services.

When the BlackStorm Server or Database Status LED in a BlackStorm Client turns red, the associated service may have stopped. Use the BlackStorm Server icon in the System tray of the BlackStorm Server computer to restart a stopped service.

**To control BlackStorm Server services:**

1. To stop a service, right-click the **BlackStorm Service Manager** icon in the **System Tray** and select one of the following commands:

<table>
<thead>
<tr>
<th>Service</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>BlackStorm Server</td>
<td>BlackStorm Server &gt; Stop</td>
</tr>
<tr>
<td>Database</td>
<td>Database &gt; Stop</td>
</tr>
<tr>
<td>Service Location Protocol</td>
<td>SLP &gt; Stop</td>
</tr>
<tr>
<td>All</td>
<td>Stop All</td>
</tr>
</tbody>
</table>

   ✴ Stopping the SLP service also stops the BlackStorm Server service.

   The **BlackStorm Service Manager** icon turns red when the BlackStorm Service is stopped.

2. To start a service, right-click the **BlackStorm Service Manager** icon in the **System Tray** and select one of the following commands:

<table>
<thead>
<tr>
<th>Service</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>BlackStorm Server</td>
<td>BlackStorm Server &gt; Start</td>
</tr>
<tr>
<td>Database</td>
<td>Database &gt; Start</td>
</tr>
<tr>
<td>Service Location Protocol</td>
<td>SLP &gt; Start</td>
</tr>
<tr>
<td>All</td>
<td>Start All</td>
</tr>
</tbody>
</table>

   The **BlackStorm Service Manager** icon turns green when the BlackStorm Service is running. Starting the BlackStorm Server service also starts the SLP service.
Server Configuration

The BlackStorm Server Configuration Client provides access all of the properties to set up the BlackStorm Server inputs and outputs. Before you can use a BlackStorm Server to playout video, you must use the Configuration Client to set BlackStorm Server to configure the BlackStorm Server communication, inputs, and outputs.

This chapter discusses the following topics:

- Logging on to the Server
- Network Connections
- Server Performance
- Firewall Configuration
- Client Configuration
- Channel Name Configuration
- GenLock Configuration
- Remote Control Configuration
- House Time Configuration
- Channel Time Configuration

The BlackStorm Server Configuration Client does not contain all available BlackStorm Server configuration settings. To configure settings for some BlackStorm Server features, you must use a text editor to a configuration file. For information on setting BlackStorm Server configuration settings that are not available in the Configuration Client, refer to “Appendix B. Configuration File Settings” on page 10–1.
Logging on to the Server

Each BlackStorm server comes with a couple of Windows accounts you can use to work directly from the BlackStorm Server.

* Ross Video recommends maintaining BlackStorm Server passwords as per your company password policy.

Default User

Use the BlackStorm account for routine operation of the BlackStorm Server and to configure the Server. Use the following credentials to log on to the BlackStorm Server as the default user:

- **User name** — blackstorm
- **Password** — blackstorm

Administrator

Use the Administrator account to manage the operating system of a BlackStorm Server, or to run consistency checks on the system and the media drives. Use the following credentials to log on to the BlackStorm Server as the default user:

- **User name** — administrator
- **Password** — pr0gram

When entering the password, use the number zero (0) to replace the letter “o”.

Network Connections

In order for the BlackStorm Server to function, it must have a connection to a network. A network connection enables remote access to the BlackStorm Server, and remote BlackStorm Clients to access media stored on the BlackStorm Server.

* Ross Video recommends that a qualified Network Administrator perform any required network configurations. Some network settings, if configured incorrectly, could prevent the BlackStorm Server from communicating on the network.

Keep the following in mind when configuring the BlackStorm Server network connections:

- If the network within the production environment does not use bridges to connect subnets, the BlackStorm Server must have a connection to the same subnet as the remote client computers.
- When assigning an IP address to the BlackStorm Server, Ross Video recommends assigning a static IP address, rather than using DHCP to dynamically assign an IP address. Since the static IP address of the BlackStorm Server does not change when the server restarts, BlackStorm Clients can always connect the BlackStorm Server without having to reconfigure the BlackStorm Server IP address.

Multiple Network Interface Cards

When configuring a BlackStorm Server with multiple network interface cards, you must bind the static IP address of the BlackStorm Server to one of the network interface cards. You must also set the selected network interface card as the first network connection that network services access.

Complete the following procedures to set the BlackStorm Server IP address for FTP, BlackStorm Client user interface, and external controllers (VDCP and AMP):

To set the BlackStorm Server network connection as the first connection accessed by network services:

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.
2. From the Windows desktop, open the **Start** menu.
3. In the **Search programs and files** box, enter the **prompt** command.
4. In the **Command Prompt** window, enter the `ipconfig` command.

5. In the report displayed by the `ipconfig` command, note the name of the network connection associated with the IP address of your BlackStorm Server.

   step 12 on page 3-3 requires the name of the BlackStorm Server network connection.

6. From the **Start** menu, select **Control Panel**.

7. In the **Control Panel** window, use the **View by menu** to select **Large icons**.

8. Click the **Network and Sharing Center** icon.

9. In the **Network and Sharing Center** window, click **Change adapter settings** in procedures list along the left side of the window.

10. Press **ALT** to display the **Menu** toolbar.

11. Use the **Advanced** menu to select **Advanced Settings**.

12. In the **Connections** list of the **Advanced Settings** dialog box, move the BlackStorm Server network connection to the top of the list.

   Use the BlackStorm Server network connection name obtained in step 5 on page 3-3.

13. Click **OK** to save changes and close the **Advanced Settings** dialog box.

14. Restart the BlackStorm Server computer.

15. Close and reopen any DashBoard windows open on the BlackStorm Server.

**To set the BlackStorm Server IP address for FTP:**

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.

2. Navigate to the `C:\Ross\BlackStorm` folder.

3. Use a text editor to open and edit the `FTPConfig.xml` file.

4. In the `FTPConfig.xml` file, locate the following line of text:

   ```xml
   <m_strBoundIp type="string"/>
   </m_strBoundIp>
   ```

5. Replace the found line of text with the following line of text, where `192.168.1.1` is the IP address or hostname of your BlackStorm Server:

   ```xml
   <m_strBoundIp type="string">192.168.1.1</m_strBoundIp>
   ```


7. Stop and restart the BlackStorm Server service running on the BlackStorm Server.

**To set the BlackStorm Server IP address for the user interface of BlackStorm Clients:**

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.

2. Navigate to the `C:\Ross\BlackStorm` folder.

3. Use a text editor to open and edit the `HttpConnectionServiceConfig.xml` file.

4. In the `HttpConnectionServiceConfig.xml` file, locate the following line of text:

   ```xml
   <m_boundAddress type="string"/>
   </m_boundAddress>
   ```

5. Replace the found line of text with the following line of text, where “192.168.1.1” is the IP address or hostname of your BlackStorm Server:

   ```xml
   <m_boundAddress type="string">192.168.1.1</m_boundAddress>
   ```


7. In the `SOAPConfig.xml` file, locate the following line of text:

   ```xml
   <m_boundAddress type="string"/>
   </m_boundAddress>
   ```
8. Replace the found line of text with the following line of text, where “192.168.1.1” is the IP address or hostname of your BlackStorm Server:

   `<m_boundAddress type="string">192.168.1.1</m_boundAddress>`


10. Restart the BlackStorm Server computer.

To set the BlackStorm Server IP address for external controllers:

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.

2. Navigate to the C:\Ross\BlackStorm folder.

3. Use a text editor to open and edit the ControllerPortsConfig.xml file.

4. In the ControllerPortsConfig.xml file, locate the following line of text:

   `<m_boundIpAddress type="string"></m_boundIpAddress>`

5. Replace the found line of text with the following line of text, where 192.168.1.1 is the IP address or hostname of your BlackStorm Server:

   `<m_boundIpAddress type="string">192.168.1.1</m_boundIpAddress>`


7. Restart the BlackStorm Server computer.

Server Performance

Virus scanning software and Automatic Updates can impact the performance of a BlackStorm Server. To ensure peak performance, BlackStorm Servers are shipped from the factory as follows:

- Virus scanning software not installed
- Automatic Updates turned off

Contact Ross Technical Support for information about running virus scanning software or Automatic Updates on a BlackStorm Server.

Firewall Configuration

To use BlackStorm Server software directly from the BlackStorm Server, you must disable the Windows Firewall on the server computer. A Firewall stops BlackStorm Clients from launching or functioning properly.

∗ The BlackStorm Server ships from the factory with the Firewall disabled.

To disable the Windows Firewall on the BlackStorm Server:

1. From the Start Menu, select Control Panel.

   The Control Panel window opens.

2. Use the View by list to select Large icons.

3. Click the Windows Firewall control panel.

   The Windows Firewall window opens.

4. In the panel to the left, select Turn Windows Firewall on or off.

   The Customize Settings window opens.

5. For each Network Location, select the Turn off Windows Firewall option.

6. Click OK to disable the Firewall on the BlackStorm Server.

7. Close the Control Panel window.
Client Configuration

You must set the FTP server address and communications ports to enable loading and exporting of media items onto and from the BlackStorm Server.

To configure FTP server settings and the client information logging level:

1. Use one of the following methods to launch the DashBoard software:
   - Double-click the **DashBoard** icon on the desktop.
   - Use the **Start** menu to select **All Programs > DashBoard > DashBoard**.
     
     DashBoard opens.

2. In the DashBoard **Tree View**, expand your **BlackStorm Server** node.
   
   The **BlackStorm Server** node displays the available channels, applications, and tools.

3. Expand the **Configuration Tools** node.
   
   The **Configuration Tools** node displays the available configuration tools.
4. Double-click the **Configure Client** node 🠡.

   The **Configuration Client** opens in the **Device View**.

5. Click the **Client** tab.

   The **Client** tab opens.

6. An FTP Server runs on the BlackStorm Server computer to enable file transfers between the BlackStorm Server and the Media Manager or FTP client. The available FTP server address settings for the **FTP Server Address** box are as follows:

   - **default** or **0.0.0.0** — enables connection of any active IP interface to the FTP service. For BlackStorm Servers that use a single network interface card, the setting indicates that the FTP address is the same as the address displayed in the Server Name field.
   - **Specific IP address** — limits FTP service response to communication sessions on the IP interface associated with the entered IP address.

   If the IP address entered in the **FTP Server Address** box does not match one of the IP addresses configured for the BlackStorm Server, the FTP service will not function for the BlackStorm Server.

   When a BlackStorm Server computer contains two network interface cards, complete the following steps to set the IP address of the BlackStorm FTP Server:

   a. Enter the IP address of the second network interface card in the **FTP Server Address** box.

   Check with your IT Department if you do not know the IP address or hostname of your BlackStorm or FTP Server.

   b. In Windows, Navigate to the **C:\Ross\BlackStorm** folder.

   c. Edit the **FTPConfig.xml** file and locate the following line of text:

   ```xml
   <m_strBoundIp type="string"/>
   ```

   d. Replace the found line of text with the following line of text, where **192.168.1.1** is the IP address entered in the **FTP Server Address** box:

   ```xml
   <m_strBoundIp type="string">192.168.1.1</m_strBoundIp>
   ```

   e. Save the updated **FTPConfig.xml** file.

   f. Stop and start BlackStorm Server service.

7. In the **FTP Data Port** box, enter the port number used by the FTP Server on the BlackStorm Server computer to exchange data with BlackStorm Clients.

   The default FTP Data Port is port 20.
8. In the **FTP Control Port** box, enter the port number used to control the FTP Server on the BlackStorm Server computer.

The default FTP Control Port is port 21.

9. In the **Client Diagnostics** section, use the **Logging Level** list to select the level of information to log. You can use logs to help with troubleshoot client connection issues. Messages more severe than the selected level are logged along with the selected logging level. Select from the following logging levels:
   - **SEVERE** — log messages indicating a serious failure. This level captures the least information.
   - **WARNING** — log messages indicating a potential problem, including SEVERE messages.
   - **INFO** — log informational messages, including SEVERE and WARNING messages.
   - **ALL** — log SEVERE, WARNING, and INFO messages. This level captures the most information and may impact server performance.

10. Click **Apply**.

**To save Blackstorm Server log files in a log bundle:**

1. In the **Client Diagnostics** section of the **Configuration Client**, click the **Grab Logs** button.

   The **Location to Save Log Bundle** dialog box opens showing the local file system of the computer running the DashBoard application.

![Location to save log bundle](image)

2. Locate the folder in which to save the BlackStorm Server log files, and then click **Location to Save Log Bundle**.

   A .ZIP file is the container that stores all of the BlackStorm Server log files in the selected folder. The filename for the .ZIP file conforms to the following format:

   BVS_logs_<current date and time>_<local computer name>.zip

   For example:

   BVS_logs_2013_12_17__16_12_THUSHOVD-XPS.zip

3. To view individual log files, open the BlackStorm Server log bundle file (.zip).

**For More Information on...**

- stopping and starting the BlackStorm Server service, refer to the section “**BlackStorm Server Services**” on page 2–19.
Channel Name Configuration

You can add names to channel numbers to help clarify selecting an output channel from a BlackStorm Client. Use the Channel Name tab in the Configuration Client to set BlackStorm Server channel names. Channel names set on a remote computer are only available on that computer. BlackStorm Clients run on a remote computer use the channel names set on that computer.

To assign names to the channels of a BlackStorm Server:

1. In the Configuration Client, click the Channel Names tab.

   The Channel Names tab opens.

2. For each BlackStorm Server Output Channel, enter a name for the channel in the Name box to the right of the channel number. Twenty characters is the maximum length for a channel name.

   To clear the current channel name from the Name box associated with a channel, click Clear to the right of the Name box. Click Clear All to clear channel names from all of the Name boxes.

   Channels with an empty Name box automatically receive the channel name of “Channel” and the channel number, for example “Channel 3”.

3. Click Apply.

   BlackStorm Clients and nodes in the DashBoard Tree View immediately make use of the set channel names.

GenLock Configuration

Use the GenLock tab in the Configuration Client to set BlackStorm Server video output GenLock properties. This tab is also sets the resolution for all BlackStorm Server output channels.

* Before you change the output channel resolution, you must idle all channels and eject all media items.
To configure BlackStorm Server GenLock and global output settings:

1. In the Configuration Client, click the GenLock tab.
   
   The GenLock tab opens.

2. In the Resolution section, use the Resolution list to select the proper resolution for all BlackStorm Server output channels. The available resolutions are as follows:
   - 1080i 50 — 1920 x 1080 interlaced resolution with a field rate of 50 Hz
   - 1080i 59.94 — 1920 x 1080 interlaced resolution with a field rate of 59.94 Hz
   - 1080p 29.97 — 1920 x 1080 progressive resolution with a frame rate of 29.97 Hz
   - 720p 50 — 1280 x 720 progressive resolution with a frame rate of 50 Hz
   - 720p 59.94 — 1280 x 720 progressive resolution with a frame rate of 59.94 Hz
   - 480i — 480 interlaced lines (NTSC) with a field rate of 59.94 Hz
   - 576i — 576 interlaced lines (PAL) with a field rate of 50 Hz

3. In the Source section, use the Source list to select the source of the genlock signal. The BlackStorm Server requires a genlock signal to lock the server to the video timing of your facility. Ross Video recommends using an external reference for the genlock signal source.
   
   The available genlock signal sources are as follows:
   - Free Run — do not synchronize the BlackStorm Server with a genlock signal from an external source.
     
     Ross Video recommends using an external reference for the genlock signal source. Only select Free Run as the genlock signal source in an emergency.
   - External — synchronize with a genlock signal from an external source through the REF IN BNC connector of the BlackStorm Server computer. The BlackStorm Server accepts Analog Color Black or HD Tri-level sync genlock signals. Ross Video recommends Tri-level sync for progressive and HD formats.

   The Genlock Status LED icon uses the following states to indicate the status of the selected genlock signal source for the BlackStorm Server:
   - — locked to the genlock signal source
   - — free running
   - — not locked to the genlock signal source

4. Click Apply to save the GenLock and resolution settings.
Remote Control Configuration

Before you can control a BlackStorm Server from a remote device, you must first configure the server control ports and select the communications protocol.

To configure the remote control ports and the communication protocol:

1. In the Configuration Client, click the Remote Control tab.

   The Remote Control tab opens.

2. To control the BlackStorm Server with a remote device connected to a Serial Control port of the BlackStorm Server computer, use the Com3 and Com4 lists to set the communication protocol for the associated RS-422 Serial Control port of the Breakout cable or panel connected to the BlackStorm Server. The available communication protocols are as follows:

   - **VDCP** — receive VDCP commands through the associated Serial Control port. The VDCP protocol uses a tightly-coupled master/slave method of communication. The controlling device initiates communication between itself and the controlled device.
   - **None** — do not receive remote control commands through the associated Serial Control port.

3. Select the Enable VDCP over Ethernet check box to receive Video Disk Communications Protocol (VDCP) commands through the GigE Ethernet port on the back of the BlackStorm Server.

4. Select the Enable AMP over Ethernet check box to receive Advanced Media Protocol (AMP) commands through the GigE Ethernet port on the back of the BlackStorm Server.

   The BlackStorm Server supports AMP control by the Ross Video Carbonite switcher. Ross Video does not certify AMP control of the BlackStorm Server with any other control devices.

5. Select the Use Server-entered Trimpoints check box to use media item trimpoints when the BlackStorm Server does not receive trimpoints from an upstream controller as part of a VDCP Cue command.

   The BlackStorm Server always uses trimpoints received from an upstream controller, regardless of this check box setting.

6. Click Apply to save the remote control settings.

   An Info dialog box opens.
7. Click **OK**.

**For More Information on...**
- BlackStorm Server supported VDCP commands, refer to the section “VDCP Commands for the BlackStorm Server” on page 9–3.
- Serial Control port pinouts, refer to the section “Communication Serial Port” on page 9–5.

### Mapping VDCP Ports

The BlackStorm Server uses a one to one mapping to set the association between BlackStorm Server channel to control and VDCP port. For example, VDCP port 1 controls Server output channel 1. Use the Port Mapping dialog box to set Custom VDCP port mappings.

**To set the BlackStorm Server channel controlled by a VDCP port:**

1. In the **Remote Control** tab of the **Configuration Client**, click **VDCP Port Mapping**.
   
   The **Port Mapping** dialog box opens.

   ![Port Mapping Dialog Box](image)

2. Use the **Port** box to enter or select the VDCP port to control a BlackStorm Server channel. The available VDCP ports are 1 to 256.

3. Use the **Channel Type** list to select the type of BlackStorm channel controlled by the selected VDCP Port. The available channel types are as follows:
   - **Output** — control an output channel, selected from the **Channel** list.
   - **None** — do not control a channel.

4. Use the **Channel** list to select the Output channel on the BlackStorm Server to control. The available channels depend on the selected **Channel Type** and BlackStorm Server configuration.

5. Click **OK** to save the set VDCP port mappings and close the **Port Mapping** dialog box.
   
   An **Info** dialog box opens.

6. Click **OK**.
House Time Configuration

Use the House Time tab in the Configuration Client to select and configure the house time signal source for a BlackStorm Server. After selecting and configuring a house time signal source, use the Timecode Client to view the current house time.

To configure the house time source for a BlackStorm Server:

1. In the Configuration Client, click the House Time tab.
   The House Time tab opens.

2. Select one of the following options to choose the time signal source used to set house time:
   - None — do not receive a time signal for house time and do not display the current house time (--:--:--:--) in the House Time section of the Timecode Client.
   - LTC — set house time using a Linear Timecode (LTC) time signal from one of the LTC In ports on the back of the BlackStorm Server. After selecting this option, continue with step 3 in this procedure.
   - NTP Server — set house time using a time signal from a Network Time Protocol (NTP) server. After selecting this option, continue with step 4 in this procedure.

   The timecode returned by a NTP server is Coordinated Universal Time (UTC). To display the local time in the House Time section of the Timecode Client, you must set the local time zone on the BlackStorm Server computer. To set the local time zone on the BlackStorm Server:
   - Log on to the BlackStorm Server computer as the blackstorm user.
   - From the Start Menu, select Control Panel.
   - In the Control Panel window, use the View by list to select Large icons.
   - Click the Date and Time control panel.
   - In the Time zone section of the Date and Time dialog box, click Change time zone.
   - In the Time Zone Settings dialog box, use the Time zone list to select the local time zone.
   - Select the Automatically adjust clock for Daylight Saving Time check box.
   - Click OK.
   - In the Date and Time dialog box, click OK.
   - Close the Control Panel window.
3. Use the list to the right of the LTC option to select the LTC In port number on the back of the BlackStorm Server from which to receive a time signal for house time.

   After selecting this option, continue with step 7 in this procedure

4. In the box to the right of the NTP Server option, enter the IP address or hostname of the NTP Server from which to receive a time signal for house time.

5. Click Test NTP to verify that the Black Storm Server can receive a time signal from the selected NTP server.

6. In the Polling Interval box, enter the number of seconds to wait between consecutive connections to the NTP server for values used to update the local house time on the BlackStorm Server.

   Shorter polling intervals can correct large errors in local house time, while longer intervals can help refine local house time accuracy.

7. Click Apply to save the House Time settings.

   When House Time settings have changed, complete the following steps:

   a. Click OK to close the Server Restart Required alert.

   b. Restart the BlackStorm Server computer to make the changes take effect.

Channel Time Configuration

Use the Channel Time tab in the Configuration Client to set how to output the timecode signal from each BlackStorm Server output channel.

When the media item loaded on a channel contains a QuickTime Timecode Track, the BlackStorm Server outputs the timecode from the QuickTime Timecode Track through the set timecode output. When a loaded media item does not contain a QuickTime Timecode Track, the BlackStorm Server uses the media item frame count to generate a timecode for output through the set timecode output.

* When a BlackStorm Server sends out a timecode signal as an Ancillary Time Code (ATC) or through a Linear Timecode (LTC) port, the Frames field of the timecode complies with the 30 frames per second (fps) limit in accordance with the SMPTE 12M-1-2008 specification.
To configure the timecode output from a BlackStorm Server channel:

1. In the Configuration Client, click the Channel Time tab.
   
The Channel Time tab opens.

2. For each Channel # section, configure the following timecode settings:
   
a. Select the ATC (VITC) Insertion check box to embed the timecode retrieved from the media item playing out on the selected channel of the BlackStorm Server as VITC in the ATC space.

b. Select the ATC (LTC) Insertion and Analog LTC Output check box to embed the timecode retrieved from the media item playing out on the selected channel of the BlackStorm Server as LTC in the ATC space.
   
   Analog LTC output through the LTC 1 Out and LTC 2 Out ports on the back of the BlackStorm Server is only available for channels 1 and 2.

   c. Use the Timecode list to select the timecode counting direction for the selected channel. The available timecode counting directions are as follows:
      
      • Ascending — the timecode counts up from the start of a media item to report the length of time that the media item has played out.
      • Descending — the timecode counts down from the end of a media item to report the remaining time that the media item can playout.

3. Click Apply to save the Channel Time settings.
BlackStorm Client Layout

The BlackStorm Client applications used to control and configure a BlackStorm Server are part of the Ross Video DashBoard Control System™ application. DashBoard enables monitoring and control of one or more BlackStorm Servers from a computer. Through DashBoard, you can create and save custom BlackStorm Client application layouts that match your workflow.

DashBoard is a free application that comes pre-installed on every BlackStorm Server. You can also install DashBoard on other computers to control BlackStorm Servers connected to the same Local Area network as these computers. The BlackStorm Server Software DVD shipped with the BlackStorm Server contains the DashBoard application installer. The installer is also downloadable from the Ross Video website.

This chapter discusses the following topics:

- Connecting to a BlackStorm Server
- Accessing BlackStorm Clients in Dashboard
- Creating a BlackStorm Client Layout
- Additional DashBoard Windows for BlackStorm Clients
- Saving and Recalling BlackStorm Client Layouts

The procedures in this chapter build upon each other to create a well-suited layout for playing out media items from the BlackStorm Server. The completed layout enables easy access to the Media Manager, Channel, and Playlist clients.

For More Information on...

- Dashboard, refer to the DashBoard User Guide.
- how to download the Dashboard application installer, refer to the following section of the Ross Video website:
  - Products | Terminal Equipment | openGear | Control & Monitoring | DashBoard

Figure 4.1  Completed Layout
Connecting to a BlackStorm Server

After installing DashBoard on a remote computer, you then add the BlackStorm Server or Servers to control to the DashBoard Tree View. The DashBoard Tree View displays each BlackStorm Server as a node (Figure 4.2). Each BlackStorm Server node contains the BlackStorm Clients used to control the associated BlackStorm Server. The name of a BlackStorm Server node comes from the BlackStorm Server IP address or hostname.

![BlackStorm Server Node in the DashBoard Tree View](image)

**Figure 4.2** BlackStorm Server Node in the DashBoard Tree View

Connection Status

The LED in the lower right corner of a BlackStorm Server node indicates the current connection status between DashBoard and the BlackStorm Server. The LED reports the following connection states:

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="green LED" /></td>
<td>A connection exists between DashBoard and the BlackStorm Service running on the BlackStorm Server computer.</td>
</tr>
<tr>
<td><img src="image" alt="yellow LED" /></td>
<td>DashBoard is trying to establish a connection with the BlackStorm Server, but there may be a connectivity problem. For example, there is no FTP connection with the BlackStorm Server.</td>
</tr>
<tr>
<td><img src="image" alt="red LED" /></td>
<td>There is not a connection between DashBoard and the BlackStorm Service running on the BlackStorm Server computer. Check with your IT Department to verify that the BlackStorm Service and Server are running.</td>
</tr>
<tr>
<td><img src="image" alt="red LED" /></td>
<td>The connect state between DashBoard and the BlackStorm Server is unknown.</td>
</tr>
</tbody>
</table>

Accessing BlackStorm Clients in Dashboard

After adding a BlackStorm Server to DashBoard, BlackStorm Clients are available to configure and control the BlackStorm Server. The BlackStorm Server node contains all of the available BlackStorm Clients.

To open BlackStorm Clients:

1. In the DashBoard Tree View, expand your BlackStorm Server node.

The expanded BlackStorm Server node lists the available channels, applications, and tools.

`Media-One

Channels

Control Applications

Configuration Tools`
2. Expand the **Channels**, **Control Applications**, and **Configuration Tools** nodes to access the available BlackStorm Clients.

The available BlackStorm Clients are as follows:

![BlackStorm Client Layout](image)

Creating a BlackStorm Client Layout

You can select BlackStorm Clients from the Tree View and open them in the Device View to the right of the Tree View. Newly opened BlackStorm Clients occupy the entire Device View. After opening multiple BlackStorm Clients in the Device View, you can move and resize the clients to tailor the Device View to your workflow. You can create and save multiple Device View layouts.

**To position BlackStorm Clients in the Device View:**

1. In the DashBoard **Tree View**, expand the **BlackStorm Server** node and all of the nodes it contains.

2. In the **Channels** node, use one of the following methods to open **Output Channel 1** in the **Device View**:
   - Double-click the **Output Channel 1** node.
   - Right-click the **Output Channel 1** node and select **Open** from the **Shortcut** menu.

**Output Channel 1** opens in the Device View tab.
3. In the **Channels** node, double-click the **Output Channel 2** node.

   **Output Channel 2** opens in a second Device View tab, overlapping the Output Channel 1 tab.

4. In the **Control Applications** node, double-click the **Media Manager** node.

   The **Media Manager** opens in a third Device View tab, overlapping the other open tabs.
5. In the **Control Applications** node, double-click the **Playlist Client** node.

The **Playlist Client** opens in a third Device View tab, overlapping the other open tabs.

6. To access a **BlackStorm Client**, click the client tab at the top of the **Device View**.

You may need to move and resize BlackStorm Clients in the Device View to form a layout that displays all relevant clients at once.

**To Move a BlackStorm Client:**

1. In the **Device View**, place the mouse pointer on the title bar of the **BlackStorm Client** (Media Manager) to move, then click and hold the mouse button.

2. Drag the selected **BlackStorm Client** to a new location in the **Device View** (left side).

As the client is dragged, a gray outline and an arrow preview the new location for the view.
3. Release the mouse button to place the **BlackStorm Client** at the selected location.

4. Move the **Output Channel 2** client to the top right corner of the **Device View**.
5. Move the **Output Channel 1** client to the left of the **Output Channel 2** client in the **Device View**.

After moving the last BlackStorm Client, the layout of the Device View is as follows:

You can resize any BlackStorm Client in the Device View to fine-tune the layout.
To resize a BlackStorm Client:

1. In the Device View, place the mouse pointer on a border of the BlackStorm Client (Playlist Client) to move, then click and hold the mouse button.

2. To change the height of a BlackStorm Client (Play Client) in the Device View, place the mouse pointer on the top or the bottom border of the client.

3. To change the width of a BlackStorm Client (Play Client) in the Device View, place the mouse pointer on the left or right border of the client.
4. When the mouse pointer changes to a double-headed arrow, click and drag the border to shrink or enlarge the BlackStorm Client.

5. Release the mouse button to set the size of the BlackStorm Client.
To close a BlackStorm Client:

- In the tab of the BlackStorm Client to close, click Close  

Additional DashBoard Windows for BlackStorm Clients

When working on a computer with multiple monitors, you can open an additional DashBoard window to hold more BlackStorm Clients on your second monitor.

- Do not launch the DashBoard application twice to open two windows, only use the New Window command to open a second DashBoard window.

To open an additional DashBoard Window for BlackStorm Clients:

1. In the DashBoard window, use the Window menu to select New Window.

   A new DashBoard window opens.

2. Use one of the following methods to add BlackStorm Clients to the new DashBoard window:

   - In the new DashBoard window, use the DashBoard Tree View to open BlackStorm Clients.
   - Drag a BlackStorm Client from the original DashBoard window into the new DashBoard window.

   The selected BlackStorm Client closes in the original DashBoard window and opens in the new DashBoard window.

For More Information on...

- opening BlackStorm Clients, refer to the procedure “To open BlackStorm Clients:” on page 4–2.

Saving and Recalling BlackStorm Client Layouts

After setting BlackStorm Client positions in the Device View, you can save the client layout. Each layout saves the DashBoard window state, size, and position. Layouts do not save the background and the text color of a client set using the Color Chooser dialog box.
To save a BlackStorm Client layout:

1. In DashBoard, use the Layouts menu to select Save Layout.

   The Save Current Layout dialog box opens.

2. In the Layout Name box, enter a name with which to save the current layout of the Device View.

3. Click OK.

   The entered layout name saves the current layout of the Device View. The Layouts View and the Layouts menu display new layout name.

To recall a BlackStorm Client layout:

- In DashBoard, use one of the following methods to select the layout to recall:
  - Use the Layouts menu to select the Name of the layout to recall.
  - In the Layouts View, double-click the Name of the layout to recall.

   The Device View displays the window layout as defined by the selected layout.

For More Information on...

- layouts, refer to the DashBoard User Guide.
- how to change the background and the text colors of a client, refer the chapter “Coloring BlackStorm Clients” on page 8–1.
Adding Media Items to a BlackStorm Server

You can add media items to a BlackStorm Server by importing selected media items, or by loading media items from the drop folder. Use the following BlackStorm Clients to add media items to a BlackStorm Server:

- **Media Manager** — import media files to a BlackStorm Server from any connected Client computer.
- **Media Import Wizard** — add media files to a BlackStorm Server from a selected folder.
- **FTP** — add or manage media files on a BlackStorm Server via an FTP client.

This chapter discusses the following topics:

- Targa File Resolution
- Loading Media Files through the Media Manager
- Using the Drop Folder to Load Media Files
- Importing Media Files from Selected Folders
- Managing Media Items

⭐ Ross Video recommends using the **Media Manager**, an FTP client, or a specified drop folder to add media items to a BlackStorm Server. Adding files directly to the media directory does not import the files into the Media Manager.

Adding media items to a BlackStorm Server through the file system via a specified drop folder is slower and less reliable when handling a large numbers of files. Adding media items via the **Media Import Wizard** can result in lost data (such as trimpoints) if the current database is dropped.
Targa File Resolution

When loading Targa (.TGA) files onto a BlackStorm Server, the server uses the following rules to set Targa file resolution:

- 720 x 576 Targa files imported at a resolution of 567i.
- 720 x 480 Targa files imported at a resolution of 480i.
- 1920 x 1080 Targa files imported using the set framerate at the time of the import:
  - 1080i 50 or
  - 1080i 59.94
  - 1080p 29.97
- 1280 x 720 Targa files imported using the set framerate at the time of the import:
  - 720p 50 or
  - 720p 59.94

Loading Media Files through the Media Manager

You can add media items to a BlackStorm Server by loading the following types of media files from outside of the BlackStorm Server environment onto the server:

- **QuickTime files (.MOV)** — a BlackStorm server can directly play QuickTime Standard Definition (SD) and High Definition (HD) media items that use the QuickTime Animation or the DV family of codecs.

  ✓ Stutter may occur when the BlackStorm Server RAID controller goes into Patrol Read state during the playout of high bit rate, greater than 600 Mb/sec, QuickTime Animation RLE encoded video files. Patrol Read is a disk drive consistency check that verifies the virtual disk drives for physical disk errors that could lead to drive failures. Patrol Read is a scheduled task that you can disable in extreme conditions. If you do disable Patrol Read, please schedule a time to run the Patrol Read during non-peak times. Use the Dell SAS RAID Storage Manager on the BlackStorm Server to modify the Patrol Read settings.

- **Avid DNxHD®** — a BlackStorm Server supports media files encoded with the Avid Digital Nonlinear Extensible High Definition codec at the following bit rates:
  - 145 Mb/sec, 8-bit depth
  - 220 Mb/sec, 8-bit depth

  ✓ When you render Avid DNxHD® media clips for playout on a BlackStorm Video Server at 720p50, you must render the media clips at 50fps. Rendering Avid DNxHD® media clips at other frame rates can cause incorrect video playout speed from a BlackStorm Video Server.

- **Uncompressed Targa files (.TGA)** — a BlackStorm server can directly play 24 and 32 bit Targa files.
- **Run Length Encoded Targa files (.TGA)** — a BlackStorm server can directly play 24 and 32 bit Targa files.

  ✓ When importing Targa files, note the current BlackStorm video format and the frame rate. Targa media items are only available for playout when the BlackStorm Server is running in the same format and the frame rate as it was at time of Targa file import.
To import a media file onto the BlackStorm Server:

1. In the DashBoard Tree View, expand the BlackStorm Server node.
   The expanded BlackStorm Server node lists the available channels, applications, and tools.

2. Expand the Control Applications node.
   The expanded Control Applications node lists the available applications.

3. Double-click the Media Manager node.
   The Media Manager opens in the Device View.

   - **Channel** — click a channel panel to select the channel as the default channel to load media items from the Media Items or Current Bucket areas.
   - **Refresh** — click this button to refresh the media items displayed in the Media Items list.
   - **Folders** — select from this tree view the folder containing the media items to load into channels.
   - **Bucket** — use this list to select the bucket to add media items.
   - **Contents** — this list displays the media items contained in the current bucket.
   - **To Bucket** — click this button to add the selected media items in the current bucket.
   - **Details** — click this button to view information about the selected media item in the Media Item Details dialog box.
   - **Load** — click this button to load the selected media item into the default channel.
   - **Delete** — click this button to delete the selected media item.
   - **Sort** — use this list to select the sort method for the Media Items list.
   - **Filter** — use this list to limit the media items shown in the Media Items list to those that contain a selected file type.
   - **Status LEDs** — these LEDs indicate the current status of the MediaManager Client connection with the BlackStorm Server and the Media Database.
   - **Channel #** — click a channel button to select the channel as the default to load media items from the Media Items or Current Bucket areas.
   - **Picon** — click this button to display media item picture icons in the Media Items list.
   - **Info** — click this button to display media item information and picture icons in the Media Items list.
   - **List** — click this button to only display media item information in the Media Items list.
   - **Media Items** — select from this list the media item to load into a channel, view information about, delete, or add to a bucket.
4. Verify that the **Server** and **Database** LED icons are green, indicating a valid connection between the Media Manager and the BlackStorm Server and Media Database.

5. In the **Media Items** section, click the **Directory** tab.

6. Expand the folders in the **Directory** tree view to locate the folder in which to import a media file. In the **Directory** tree view, right-click the import folder and select **Import Content** from the **Shortcut** menu.

   The **Select Source File** dialog box opens showing the local file system of the computer running the DashBoard application.

![Select Source File dialog box](image)

7. Locate the **media** file to import onto the Media Manager, and then click **Select Source File**.

   The BlackStorm Server loads the selected media file and adds it to the Media Database as a media item. The name of the new media item is the same as the media file, but without the file name extension.

**Deleting Media Items**

Deleting a media item from the BlackStorm Server removes the media item entry in the Media Database and deletes the associated media file from the BlackStorm Server. The Media Manager cannot delete the following types of media items:

- A media item that is on air.
- A playlist that is on air.

You can also use an FTP client to delete media items from a BlackStorm Server.

**For More Information on...**
- how to work with playlists, refer to the chapter “**Working with Playlists**” on page 7–1.

**To use the Media Manager to delete a media item from a BlackStorm Server:**

1. Open the **Media Manager** in the **Device View**.

2. In the **Directory** tab, use the **Directory** tree view to select the folder that contains the media item or items to delete.

   The **Media Items** list, to the right of the **Directory** tree view, displays the media items contained in the selected folder.

3. In the **Media Item** list, select the media item or items to delete.
4. Click **Delete** at the bottom of the **Media Items** list.

The **Item Deletion** dialog box opens.

5. Click **Yes**.

The BlackStorm server deletes the selected media item from the Media Database and from any associated playlists.

* You cannot delete on air media items or media items contained in an on air playlist.

When the media item selected for deletion is part of one or more playlists, the **Modify Playlists?** alert opens. Click **OK** to delete the selected media item and remove it from the associated playlists. Click **Cancel** to keep the selected media item as well as leave the associated playlists unchanged.

![Modify Playlists? dialog box]

When the media item or items selected for deletion are on air or contained in a playlist that is on air, the **Media On Air** dialog alert. Click **OK** to keep the selected media item or items and close the dialog box.

![Media On Air dialog box]

**Exporting Media Files**

You can use the Media Manager to export a copy of the media file associated with a media item from the BlackStorm Server to a folder in the local file system. Exporting a media file from the Media Manager enables you to transfer the file to another system for editing.

**To export a copy of the media file associated with a media item to a folder in the local file system:**

1. Open the **Media Manager** in the **Device View**.

2. In the **Media Item** list, locate the media item to export.

   Selecting a Targa sequence media item exports each Targa media item in the sequence as an individual Targa (.TGA) format image file.
3. Right-click the media item to export and select Export Content from the Shortcut menu.

The Select Destination Directory dialog box opens.

![Select Destination Directory dialog box]

4. Locate and select the folder on the local file system in which to save a copy of the media file associated with the media item selected for export.

5. Click Select Destination Directory.

BlackStorm exports a copy of the media file associated with the selected media item to the selected folder in the local file system.

Using the Drop Folder to Load Media Files

You can use the Drop folder on the BlackStorm Server computer to load supported media files onto a BlackStorm Server. The BlackStorm Server loads all media files placed in the Drop folder onto the BlackStorm Server and adds a media item to the Media Database for each file. The name of a new media item is the same as the media file, but without the file name extension.

After loading a media file from the Drop folder onto the BlackStorm Server, replacing the media file in the Drop folder with a revised version of the same media file does not update the associated media item on the BlackStorm Server. You must delete the associated media item from the BlackStorm Server before you load the revised media file onto the BlackStorm Server.

The BlackStorm Server does not automatically generate Picons for media items loaded onto the BlackStorm Server through the Drop folder.

To load media files onto a BlackStorm Server through the Drop folder:

1. Locally or remotely open the D:\Drop folder on the BlackStorm Server computer.
2. Copy the media files to load onto the BlackStorm Server into the D:\Drop folder.

The full path name of a media file placed in the Drop folder for loading onto the BlackStorm Server cannot be longer than 260 characters.

The BlackStorm Server loads all media files placed in the Drop folder onto the BlackStorm Server and adds a media item to the Media Database for each file. The New Items bucket in the Media Manager automatically collects all new media items.

3. Use the Media Manager to generate picons for the new media times.
For More Information on...

• how to delete media items, refer to the section “Deleting Media Items” on page 5–4.
• how to use media items in buckets, refer to the section “Working with Media Item Buckets” on page 6–7.
• how to generate a picon for a media item, refer to the procedure “To generate a new picon for a media item:” on page 6–14.

Importing Media Files from Selected Folders

The Media Import Wizard enables you to load supported media files from one or more folders onto a BlackStorm Server. The Media Import Wizard loads all of the media files in the selected folders onto the BlackStorm Server and adds a media item to the Media Database for each file. The name of a new media item is the same as the media file, but without the file name extension.

To import media files from a folder:

1. On the BlackStorm Server, use the Start menu to select All Programs > BlackStorm > Media Import.

   The Media Import Wizard dialog box opens.

   ![Media Import Wizard](image)

   - **Add Folder** — click this button to use the Browse for Folder dialog box to select a folder from which to import clips or use as a watched folder.
   - **Remove Folder** — click this button to remove the selected folder from the Folders list.
   - **Media Folder** — root folder that stores media files added to the BlackStorm Server.
   - **Additional Media Folders** — this list displays the additional folders used to store media items.
   - **Save Folders** — click this button to save the folders in the Folders list as watched folders. The BlackStorm Server must be restarted to activate new watched folders.
   - **Drop Media** — select this check box to delete all media items from the Media Database before importing new media items to the Media Database.
   - **Import** — click this button to start importing media files into the Media Database from the listed folders.
   - **Import Log** — this area displays entries from the Import Log file.

   // for more information on...

   • how to delete media items, refer to the section “Deleting Media Items” on page 5–4.
   • how to use media items in buckets, refer to the section “Working with Media Item Buckets” on page 6–7.
   • how to generate a picon for a media item, refer to the procedure “To generate a new picon for a media item:” on page 6–14.
2. Click **Add Folder**.

   The **Browse for Folder** dialog box opens.

   ![Browse for Folder dialog box](image)

3. In the **Folder** tree view, locate the folder that contains the media files to import into the BlackStorm Server.

4. Click **Open**.

   The **Browse for Folder** dialog box closes and the **Folders** list in the **Media Import Wizard** dialog box adds the selected folder.

5. To import media files from additional folders, follow step 2 on page 5-8 to step 4 on page 5-8.

   ✺ When using more than one folder to import media files, the names of all the media files contained in all of the folders must be unique. When two folders contain a media file with the same name, the Media Import Wizard only imports the media file from the uppermost of the two folders in the **Folder** tree view. The Media Import Wizard does not import the media file from the lower folder since the BlackStorm Server already contains a media item with the same name as the media file.

   Only add directories as import folders to the D: drive of the BlackStorm Server. Ross Video does not guarantee optimal performance for import folders on C: drive or external storage.

6. If the **Folders** list contains unnecessary folders, do the following:
   a. In the **Folders** list, select the unnecessary folders.
   b. Click **Remove**.
   c. For each selected folder, click **OK** to verify the removal of the folder from the **Folders** list.

7. Click **Import**.

   The Media Import wizard imports all of the supported media files in the selected folders onto the BlackStorm Server. The BlackStorm Server adds a media item to the Media Database for each media file.

8. Close the **MediaImportApp** dialog box.
Managing Media Items

You can use a mapped FTP folder or an FTP client to manage the media items on a BlackStorm Server. Media item management through FTP includes: loading media files, renaming media items, moving media items, deleting media items, creating media item folders, renaming media item folders, and deleting media item folders.

Mapped FTP Folder

Mapping the BlackStorm Server FTP server to a folder on a computer enables you to use the Windows File Explorer manage media items. BlackStorm Server does not support managing media items through a mapped FTP folder on computers that use the Apple OS X operating system.

⚠️ After changing the Media folder on the BlackStorm Server through the Media Import Wizard, you must re-map your mapped FTP folder to the new Media folder on the server.

⚠️ Do not map FTP folder to D:\. When using more than one media folder, each media folder must be mapped to an unique FTP folder to ensure correct and efficient file management.

To map the BlackStorm Server FTP server to a folder:

1. Log on to the computer from which to manage media items, the BlackStorm Server computer or a Client computer.

2. On the desktop, right-click the Computer icon and select Map Network Drive from the Shortcut menu.

   The Map Network Drive dialog box opens.
3. Click on **Connect To a Web site that you can use to Store your documents and pictures** near the bottom of the dialog box.

   The **Add Network Location** wizard opens.

4. Click **Next**.

   The **Where do you want to create this network location?** screen opens.

5. Select **Choose a custom network location**.
6. Click Next.

The Specify the location of your website screen opens.

7. Enter the following URL in the Internet or network address box, where Media-One is the hostname or IP address of your BlackStorm Server:

   ftp://Media-One/Media

   Remember, URLs are case sensitive. Your Network Administrator can provide you with the hostname or IP address of your BlackStorm Server.

8. Click Next.

   The Specify a User Name and Password if Required screen opens.
9. Clear the Log on anonymously check box.
10. Enter blackstorm in the User name box.
11. Click Next.
   
The What do you want to name this location? screen opens.

12. Enter a name for the mapped FTP folder in the Type a name for this location box.
13. Click Next.
   
The Completing the Add Network Location Wizard screen opens.

14. Clear the Open this network location when I click Finish check box.
15. Click **Finish**.

The operating system maps the selected folder to the BlackStorm Server FTP server and the **Add Network Location** wizard closes.

**To manage media items through a mapped FTP folder:**

1. Log on to the computer that contains a folder mapped to the Media folder on your BlackStorm Server.
2. On the desktop, double-click the **Computer** icon.
   
   A **File Explorer** window opens for the computer.
3. In the **File Explorer**, locate the folder mapped to the Media folder on your BlackStorm Server.
4. Double-click the mapped folder.
   
   A **File Explorer** window opens for the Media folder on your BlackStorm Server.
5. Use an open **File Explorer** to manage media items on the BlackStorm Server as follows:
   
   • drag media files into the File Explored to load the media files onto the BlackStorm Server.
   • rename media items on the BlackStorm Server.
   • move media items between folders on the BlackStorm Server.
   • delete media items from the BlackStorm Server.
   • create new folders for media items on the BlackStorm Server.
   • rename folders on the BlackStorm Server.
   • delete folders from the BlackStorm Server.

* Deleting a folder also deletes the media items contained in the folder.

**FTP Client**

You can use an FTP client to manage media items on a BlackStorm Server from a computer running the Windows or Apple OS X operating system. The FileZilla FTP client works with computers running the Windows or Apple OS X operating system and is available free of charge under the terms of the GNU General Public License.

* An FTP client used to manage files on a BlackStorm Server must support passive mode.

**To manage media items through an FTP client:**

1. Log on to the computer from which to manage media items, the BlackStorm Server computer or a Client computer.
2. Start your FTP client.
3. Use the following credentials to log on to your BlackStorm Server FTP server:
   
   • **User name** — blackstorm
   • **Password** — blackstorm
4. Open the **Media** folder on the BlackStorm Server FTP server.
5. Use your FTP client to manage media items on the BlackStorm Server as follows:
   
   • upload media files to the BlackStorm Server.
   • rename media items on the BlackStorm Server.
   • move media items between folders on the BlackStorm Server.
   • delete media items from the BlackStorm Server.
   • create new folders for media items on the BlackStorm Server.
   • rename folders on the BlackStorm Server.
   • delete folders from the BlackStorm Server.

* Deleting a folder also deletes the media items contained in the folder.
Playing Media Items from a BlackStorm Server

The Media Manager and Play Clients provide the controls to play media items from a BlackStorm Server. The Media Manager can load and playout media items on up to four channels at the same time. You can open a Play Client for each output channel on a BlackStorm Server. The Configuration Client contains the properties that set the video output GenLock for the Media Manager and Play Clients.

This chapter discusses the following topics:

• Playing Media Items
• Working with Media Item Buckets
• Custom Media Item Playout
• Viewing Multiple Timecodes in One Place
Playing Media Items

The Media Manager contains an interface to load media items and control media item playout from a BlackStorm Server. Each output channel on a BlackStorm Server has an associated Channel panel in the Media Manager. The media items loaded into the Channel panels are controlled individually.

To play a media item in the Media Manager:

1. In the DashBoard Tree View, expand your BlackStorm Server node.
   The expanded BlackStorm Server node lists the available channels, applications, and tools.

2. Expand the Control Applications node.
   The expanded Control Applications node lists the available applications.
3. Double-click the **Media Manager** node.

The Media Manager opens in the Device View.

4. Verify that the **Server** and **Database** LED icons are green, indicating a valid connection between the Media Manager and the BlackStorm Server and Media Database.

When the **Server** and **Database** LED icon is red, right-click the **BlackStorm Server** node in the **DashBoard Tree View** and select **Connect** from the **Shortcut** menu to re-connect to the BlackStorm Server.

5. In the **Channel Control Area**, click the **Channel** from which to play out a media item.

The **Channel Control Area** section highlights the selected channel. When the Media Manager does not display the **Channel Control Area**, select **View > Channel Control Area** to display the area.

6. In the **Media Items** section, click the **Directory** tab.

You can use the **Filter** list to limit the media items displayed in the **Media Items** list.

7. Expand the folders in the **Directory** tree view to locate and select the folder that contains the media item to load into the selected **Channel** panel.

The **Media Item** list to the right of the **Directory** tree displays the media items contained in the selected folder.
8. Use the **Sort** list to select the method with which to sort the media items in **Media Item** list. The available sort methods are as follows:

- **Sort by Name (case insensitive)** or **AaBbCc** — alphabetical by media item name.
- **Sort by Name** or **ABCabc** — alphabetical by media item name, except list all media items that start with an uppercase letter before those that start with a lowercase letter.
- **Sort by Date** or **Date** — numerically by media item creation date.

9. Use the **Filter** list to limit the media items displayed in the **Media Items** list. The **Filter** list contains the following file types:

- **Video Filter (MOV) or .MOV** — list the media items that contain QuickTime format video files.
- **Video Filter (TGA) or .TGA** — list the media items that contain Targa format image files or image file sequences.
- **Video Filter (ALL) or Video** — list the media items that contain QuickTime format video files or Targa (.TGA) format image file sequences.
- **Video Filter (HD) or HD** — list the media items that contain video files in High Definition (HD) format.
- **Video Filter (SD) or SD** — list the media items that contain video files in Standard Definition (SD) format.
- **No Filter (ALL) or ALL** — list all of the media items in a folder.
- **Playlists** — list all of the playlist media items on a BlackStorm Server.

10. Click **View** to select the information displayed in the Media Items list about each media item. The available view options are as follows:

- **List** — display media item file names in the Media Items list.
- **Info** — display media information and picture icons in the Media Items list. In this view, right-click an information column heading to select the information columns displayed in the Media Item list. The available information columns are as follows:
  - **Name** — media item name.
  - **Date** — the creation date of the media item.
  - **Resolution** — video format of the media item.
  - **Duration** — media item duration in the standard timecode format of 00:00:00:00 (hours, minutes, seconds, and frames).
  - **Codec** — codec used to decode the media item for playout.

  Click and drag the divider between column headings to resize column headings.

- **Icon** — display media item picture icons and file names in the Media Items list. This display option limits the file name displayed below the media item picture icon to the first 20 characters of the file name.
11. Use the **Media Item** list to select the media item to load into the selected channel.

You can expand and collapse the following types of media items:

- **Targa Media Items** — the 📦 icon indicates that a media item is a Targa sequence.

  Targa media items are only available for playout when the BlackStorm Server is running in the same format and the frame rate as it was at time of Targa file import.

  Double-click the 📦 icon to view the Targa images contained in the selected Targa sequence. The selected Targa sequence expands to display the Targa images contained in the playlist and the icon changes to 📦.

  Double-click the 📦 icon to collapse the Targa sequence to a single item.

- **Media Items with Alpha** — the 🎨 icon indicates that a media item contains an alpha channel that plays out on a secondary output channel.

- **Playlist Media Items** — the 📀 icon indicates that a media item is a playlist.

  Double-click the 📀 icon to view the media items contained in the selected playlist. The selected playlist expands to display the media items contained in the playlist and the icon changes to 📀. Double-click the 📀 icon to collapse the playlist to a single item.

12. Use one of the following methods to view details about a media item:

- Select a media item in the **Media Items** list, then click **Details**.

- Right-click a media item in the **Media Items** list, then select the **Details** command from the **Shortcut Menu**.

13. To view details about the selected media item, click **Details**.

14. After selecting a media item from the **Media Item** list, click **Load**.

  The Media Manager loads the selected media item into the selected channel and cues it for playout. The loaded channel displays the media item picon, video file name, and the current status. The Media Manager can load and playout media items on up to four channels at the same time.

  Double-click a media item in the **Media Items** list to quickly load the media item into the currently selected channel. You can also load a media item into a channel by dragging a media item from the **Media Items** list and dropping it on a **Channel** panel in the **Channel Control Area**.

15. Click the channel **Play** button to start playing the loaded media item. Clicking this button changes the button state as follows:

<table>
<thead>
<tr>
<th>Media Item State</th>
<th>Play Button</th>
<th>Click to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newly Loaded</td>
<td></td>
<td>Start playing the media item.</td>
</tr>
<tr>
<td>Playing</td>
<td></td>
<td>Pause the playing media item.</td>
</tr>
<tr>
<td>Paused</td>
<td></td>
<td>Start playing the media item.</td>
</tr>
</tbody>
</table>

16. Use the **Play** button to control the playout of the media item.

  To eject or unload a media item from a channel, drag the media item from the **Channel** and drop it on the **Media Items** list.
To use a phrase to find media items:

1. In the **Media Manager**, select a media item from the **Media Items** list.
2. Press **CTRL+F** or **F3** to find media items in the **Media Items** list.
   
   The **Find** box opens at the bottom of the **Media Items** list.

3. In the **Find** box, enter a search phrase.
   
   As you enter a search phrase, the **Media Items** list updates to display only the media items that match the entered phrase.

4. Use one of the following methods to close the **Find** box:
   
   • Click **Close** to the left of the **Find** box.
   
   • Press **ESC**.

For More Information on...

• how to position BlackStorm Clients in the DashBoard Device View, refer to the chapter “BlackStorm Client Layout” on page 4–1.

### Playing Media Items that Contain an Embedded Alpha Channel

Media items that contain an embedded Alpha Channel require two channels for playout, one channel for the video and another channel for the alpha. The Play Client opened for the Alpha channel displays message **Channel: Alpha**.

* When using a BlackStorm Server with the Ross Video OverDrive production automation system, the OverDrive operator must be aware of which media items contain an embedded Alpha Channel. OverDrive does not warn the operator that channels 3 or 4 are not available after loading channel 1 or 3 with a media item that contains an embedded Alpha Channel.

To play a media item with an embedded Alpha Channel in the Media Manager:

1. Verify that the **Server** and **Database** LED icons are green, indicating a valid connection between the Media Manager and the BlackStorm Server and Media Database.
   
   When the **Server** and **Database** LED icon is red, right-click the **BlackStorm Server** node in the DashBoard Tree View and select **Connect** from the Shortcut menu to re-connect to the BlackStorm Server.

2. In the **Media Manager**, select the channel to load a media item that contains an embedded Alpha Channel as follows:
   
   • **2 channel BlackStorm Server** — click **Channel 1** in the Channels section.
   
   • **4 channel BlackStorm Server** — click **Channel 1** or **Channel 2** in the Channels section.
   
   The **Channel Control Area** section highlights the selected channel.

3. Use the **Media Item** list to select a media item with an embedded Alpha Channel to load into the selected channel. The 🔄 icon identifies media items that contain an embedded Alpha Channel.
4. Click **Load**.

On a 2 channel BlackStorm Server, the media item loads into Channel 1 and the embedded Alpha Channel loads into Channel 2. The media item cues for playout from Channel 1.

On a 4 channel BlackStorm Server, channel pairs are as follows:
- When loading a media item into Channel 1, the embedded Alpha Channel loads into Channel 3. The media item is cues for playout from Channel 1.
- When loading a media item into Channel 2, the embedded Alpha Channel loads into Channel 4. The media item is cues for playout from Channel 2.

One of the following alerts opens when attempting to improperly load a media item with an embedded Alpha Channel.
- The **Disallowed** alert opens after attempting to load a media item with an embedded Alpha Channel on Channel 3 or Channel 4.
- The **Eject Channel #** alert opens in the following situations:
  - loading a media item with an embedded Alpha Channel into Channel 1 when Channel 3 contains a media item.
  - loading a media item with an embedded Alpha Channel into Channel 2 when Channel 4 contains a media item.
  - load a media item into Channel 3 when Channel 1 contains a media item with an embedded Alpha.
  - load a media item into Channel 4 when Channel 2 contains a media item with an embedded Alpha.

5. Click the Channel 1 **Play** button to start playing the loaded media item with an embedded Alpha Channel.

**Working with Media Item Buckets**

You can use Media item buckets to do the following:
- Quickly access groups of often used media items stored in one or more folders.
- Categorize media items (media wipes, bugs, and others).

You can quickly load selected media items directly from a bucket into a channel by clicking the Load button or by dragging the media items from the bucket on to a channel.

Adding a media item to a bucket tags the media item with the bucket name, it does not physically move the media item on the BlackStorm Server. The buckets created on a BlackStorm Server are available to all Media Managers that connect to the server.

🌟 A bucket cannot contain playlists.
Creating and Managing Buckets

You can use the Media Manager to create, manage, rename, and delete buckets.

**To create a bucket to hold media items:**

1. In the Media Manager, click the Buckets tab.
   
   The Buckets tab opens.

   ![Buckets Tab Diagram]

   - **Buckets** — this list displays the available buckets.
   - **Rename** — click this button to use the Rename Bucket dialog box to change the name of the bucket selected in the Buckets list.
   - **Delete** — click this button to delete the bucket selected in the Buckets list.
   - **Create** — click this button to use the Create Bucket dialog box to create a new bucket for media items.

2. Click Create at the bottom of the Buckets tab.
   
   The Create Bucket dialog box opens.

   ![Create Bucket Dialog]

   - **Enter Name** box, enter a name for the new bucket.

   The Media Manager supports the UTF-8 character set to enable the entry and display of international characters for bucket names.

3. Click OK.
   
   The Media Manager adds the new bucket to the Buckets list.
To load media items into a bucket:

1. In the Media Manager, click the Directory tab.

   The Directory tab opens.

2. Use the list in the Current Bucket section to select the name of the bucket to load media items.

3. Use the Directory tree view to select the folder that contains the media items to load into the current bucket.

   The Media Item list to the right of the Directory tree view displays the media items contained in the selected folder.

4. Use the Media Item list to select the media item or items to load into the current bucket.

5. Click To Bucket or drag the selected media items to the bucket.

   The Media Manager loads the selected media items into the current bucket.

To delete media items from a bucket:

1. In the Media Manager, click the Buckets tab.

   The Buckets tab opens.
2. Use the **Bucket** list to select the bucket from which to delete media items.
   The **Media Item** list displays the media items contained in the selected folder.

3. Use the **Media Item** list to select the media item or items to delete from the current bucket.

4. Click **Delete** at the bottom of the **Media Items** list.
   The **Item Deletion** dialog box opens.

5. Click **Yes**.
   The Media Manager deletes the selected media item or items from the current bucket, but does not delete the media items from the BlackStorm Server.

**To rename a bucket:**
1. In the **Media Manager**, click the **Buckets** tab.
   The **Buckets** tab opens.

2. Use the **Bucket** list to select the bucket to rename.

3. Click **Rename** at the bottom of the **Buckets** tab.
   The **Rename Bucket** dialog box opens.

4. In the **Enter Name** box, enter a new name for the selected bucket.
   The Media Manager supports the UTF-8 character set to enable the entry and display of international characters for bucket names.

5. Click **OK**.
   The Media Manager updates the **Bucket** list with the new name of the selected bucket.

**To delete a bucket:**
1. In the **Media Manager**, click the **Buckets** tab.
   The **Buckets** tab opens.

2. Use the **Bucket** list to select the bucket to delete.

3. Click **Delete** at the bottom of the **Buckets** tab.
   The **Delete Bucket** dialog box opens.
4. Click Yes.

The Media Manager deletes the selected bucket from the BlackStorm Server, but does not delete the media items contained in the bucket list from the BlackStorm Server.

Deleting a bucket from a BlackStorm Server deletes the bucket for all users that work on the server.

Loading Channels from Media Item Buckets

You can use Media item buckets to do the following:
• Quickly access groups of often used media items stored in one or more folders.
• Categorize media items (media wipes, bugs, and others).

You can quickly load selected media items directly from a bucket into a channel by clicking the Load button or by dragging the media items from the bucket on to a channel.

To load a channel from a bucket:
1. In the Channels section of the Media Manager, click the Channel panel on which to load a media item.

When the Media Manager does not display the Channel Control Area, you can use the Channel buttons to select the channel to load media items.

2. In the Media Items section, click the Buckets tab.

The Buckets tab opens.

3. Use the Bucket list to select the bucket that contains the media item to load.

The Media Item list displays the media items contained in the selected bucket.

4. Use the Media Item list to select the media item to load into the selected channel.

5. After selecting a media item from the Media Item list, click Load.

The Media Manager loads the selected media item into the selected channel and cues it for playout.

Double-click a media item in the Media Items list to quickly load the media item into the currently selected channel. You can also load a media item into a channel by dragging a media item from the Media Items list and dropping it on a Channel panel in the Channel Control Area.
Custom Media Item Playout

You can also use the Play Client to playout media items from a BlackStorm Server. The Play Client enables the following playout methods of media item playout:

• Play from any point in a media item.
• Play only a portion of a media item.
• Loop the playout of a media item.
• Play a media item one frame at a time.

* The Play Client is not able to playout individual Targa sequences. A Targa sequence must be part of a playlist to enable playout through the Play Client.

**To control media item playout in the Play Client:**

1. Open the Media Manager in the Device View.
2. In the Dashboard Tree View, expand your BlackStorm Server node.
   The expanded BlackStorm Server node lists the available channels, applications, and tools.
3. Expand the Channels node.
   The expanded Channels node lists the available output channels on the BlackStorm Server.
4. Double-click the **Output** node for the output channel on which to playout a media item. A **Play Client** opens in the **Device View** for the selected output channel.

5. Drag the media item to playout from the **Media Manager** to the **Play Client**.

   The selected media item loads onto the output channel controlled by the **Play Client**.

   Media items that contain an embedded Alpha Channel require two channels for playout, one channel for the video and another channel for the alpha. Channel pairings for media items with and embedded Alpha Channel are as follows:

<table>
<thead>
<tr>
<th>System</th>
<th>Video Channel</th>
<th>Alpha Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Channel</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>4 Channel</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>4</td>
</tr>
</tbody>
</table>

   The Play Client opened for the Alpha Channel displays the message **Channel: Alpha**.

6. Click **Play** in the playout controls along the bottom of the **Play Client**.

   The **Timecode** displays the hours, minutes, seconds, and frames of the current position of the play head or the time remaining in the media item. The play head on the **Timecode Progress Bar** graphically indicates the current position of the play head in the media item. Use the **View > Time Code Font Size** command to set the size of the timecode numbers.

7. Click **Pause** in the playout controls.
8. Click **Rewind** to move the play head to the start of the media item, or click **Fast Forward** to move the play head to the end of the media item.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔁</td>
<td><strong>Rewind</strong> — rewind the media item to the In Point.</td>
</tr>
<tr>
<td>⏩</td>
<td><strong>Fast Forward</strong> — fast forward the media item to the Out Point.</td>
</tr>
</tbody>
</table>

9. Click and drag the play head along the **Timecode Progress Bar** to advance or rewind to a specific point in a media item. To move the play head to a specific timecode:

   a. Use the **Media** menu to select **Jump to Timecode**.

   The **Jump to Timecode** dialog box opens.

   ![Jump to Timecode dialog box](image)

   In the **Timecode** box, use the standard timecode format of 00:00:00:00 (hours, minutes, seconds, and frames) to enter the timecode at which to place the play head.

   Do not enter timecodes that are less than the In Point or greater than the Out Point timecodes set for the media item.

   c. Click **Jump**.

   The play head moves to the enter timecode on the **Timecode Progress Bar**. The play head does not move when the entered timecode is less than the In Point or greater than the Out Point timecodes set for the media item.

10. After playing a media item, click **Eject** to unload the media item loaded in the current channel of the **Play Client**.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔁</td>
<td><strong>Eject</strong> — unload the current media item from the Play Client.</td>
</tr>
</tbody>
</table>

Use the **Color Chooser** dialog box to change the background and the text color for each channel open in a Play Client. When using multiple channels on a BlackStorm Server, identifying each channel with a different color can be very helpful in enabling an operator to quickly differentiate between channels. For more information, refer to the chapter “**Coloring BlackStorm Clients**” on page 8–1.

**To generate a new picon for a media item:**

1. In the **Media Manager**, select the media item for which to generate a picon.

2. Load the selected media item into an open **Play Client** in the **Device View**.

3. Click **Play** to start playout of the loaded media item.

4. When the media item frame to use as the new picon displays on the monitor, click **Pause**.

5. Use the **Media** menu to select **Generate Picon**.

   The Play Client generates a new picon for the media item from the paused frame and displays the picon in the Picon Viewer. Newly generated picons replace existing picons.
To set the In Point and Out Point to play a portion of a media item:

1. In the Media Manager, select the media item to playout.
2. Load the selected media item into an open Play Client in the Device View.
3. Use one of the following methods to adjust the In Point for the media item:
   • Click and drag the In Point (green) marker along the Timecode Progress Bar to set the position of the media item In Point. The In Point Timecode box displays the timecode of the new In Point.
   • Click the In Point Mark icon to the right of the In Point Timecode box to set the play head position as the media item In Point. The In Point (green) marker moves to the play head position on the Timecode Progress Bar and the In Point Timecode box displays the timecode of the new In Point.
   • Use the Media > Jump to Timecode command to position the play head at an entered timecode. After positioning the play head, click the In Point Mark icon to the right of the In Point Timecode box to set the play head position as the media item In Point. The In Point (green) marker moves to the play head position on the Timecode Progress Bar.

The Play Client automatically saves the new In Point position with the media item.

4. Use one of the following methods to adjust the Out Point for the media item:
   • Click and drag the Out Point (red) marker along the Timecode Progress Bar to set the position of the media item Out Point. The Out Point Timecode box displays the timecode of the new Out Point.
   • Click the Out Point Mark icon to the right of the Out Point Timecode box to set the play head position as the media item Out Point. The Out Point (red) marker moves to the play head position on the Timecode Progress Bar.
   • Use the Media > Jump to Timecode command to position the play head at an entered timecode. After positioning the play head, click the Out Point Mark icon to the right of the Out Point Timecode box to set the play head position as the media item Out Point. The Out Point (red) marker moves to the play head position on the Timecode Progress Bar.

The Play Client automatically saves the new Out Point position with the media item.

5. Click Cue to cue the media item to the set In Point and ready it for playout.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cue — return the play head to the In Point set for the media item. After cueing the media item, use the Play Controls to begin playout from the new In Point.</td>
</tr>
</tbody>
</table>

6. Click Play in the playout controls to start playing the media item from the In Point and continue playing until the play head reaches the Out Point or you click Pause.

Use the playout controls to control media item playout.
To loop the playout of a media item:

1. In the Media Manager, select the media item to playout.
2. Load the selected media item into an open Play Client in the Device View.
3. Click Loop in the playout controls to turn the loop mode on and start playout from the play head location.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop</td>
<td>click to turn loop mode on. A playing media continues playout until the play head reaches the Out Point where it loops back to the In Point and restarts playout of the media item. Looping playout continues until you turn loop mode off.</td>
</tr>
</tbody>
</table>

4. When the loop mode is on, the arrows on the Loop button turn green. When the Loop button arrows are green, click Loop to turn off loop mode.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop On</td>
<td>click to turn loop mode off. A playing media item continues playout until the play head reaches the Out Point and stops the playout.</td>
</tr>
</tbody>
</table>

To view a media item one frame at a time to locate an exact frame:

1. In the Media Manager, select the media item to playout.
2. Load the selected media item into an open Play Client in the Device View.
3. Click Play in the playout controls to begin playing the media item.
4. At the point to start viewing the media item one frame at a time, click Pause in the playout controls.
5. Click Frame Forward in the playout controls to view the next frame in the media item, or Frame Back to view the previous frame in the media item.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Forward</td>
<td>move one frame forward in the media item.</td>
</tr>
<tr>
<td>Frame Back</td>
<td>move one frame backward in the media item.</td>
</tr>
</tbody>
</table>

For More Information on...

- how to play out media items that contain an embedded Alpha Channel, refer to the section “Playing Media Items that Contain an Embedded Alpha Channel” on page 6–6.

Viewing Multiple Timecodes in One Place

The Timecode Client enables you to view timecodes from one or more of the following time sources in one place: House Time, Channels 1 to 4, and Playlist Channels 1 to 4. You can add time source sections to, moved within, or remove from the Timecode Client as required.

The Timecode Client displays time source timecodes in separate sections using the standard timecode format of 00:00:00:00 (hours, minutes, seconds, and frames). The timecode displayed for a channel or playlist channel restarts at 00:00:00:00 after 24 hours.
To view timecodes in the Timecode Client:

1. In the DashBoard Tree View, expand your BlackStorm Server node.
   The expanded BlackStorm Server node lists the available channels, applications, and tools.

   ![Tree View Diagram]

2. Expand the Channels node.
   The expanded Channels node lists the available output channels on the BlackStorm Server.

   ![Channels Expanded Diagram]

3. Double-click the Timecode Client node.
   The Timecode Client opens in the Device View.

   ![Timecode Client Diagram]

   - **Time Source** — This field displays the name of the time source connected to the timecodes displayed in the section.
   - **Primary Timecode** — This field displays the timecode of interest using the standard timecode format of 00:00:00:00 (hours, minutes, seconds, frames).
   - **Secondary Timecodes** — These fields display additional timecodes for a source using the standard timecode format of 00:00:00:00 (hours, minutes, seconds, frames).

   Each section in the Timecode Client displays the following timecodes for a time source:
   - **C** — current time
   - **R** — remaining time
   - **D** — the duration of the media item or playlist

   Each section displays a selected time code in a larger font to highlight it from other timecodes.

To open an additional Timecode Client in the DashBoard Device View:

1. In the DashBoard Tree View, right-click the Timecode Client node and select Open from the Shortcut menu.
   An additional Timecode Client opens in the Device View.

2. Position the new Timecode Client in the Device View.
Customizing the Timecode Client Layout

You can customize the Timecode Client for your environment as following:

- Change the highlighted timecode in a timecode source section.
- Add timecode source sections to the Timecode Client.
- Move timecode source sections within the Timecode Client.
- Remove timecode source sections from the Timecode Client.
- Compress the size of the Timecode Client.

To customize the layout of the Timecode Client:

1. To change the highlighted timecode in a section, click the section to rotate the timecode positions.

2. To add a time source section to the Timecode Client, right click the section in the Timecode Client above which to add the new section and then select the time source from the Shortcut menu. Time sources include house, channel, and playlist time.

   The Timecode Client adds the new section above the selected section.

3. To move a section within the Timecode Client:
   a. Place the mouse pointer on the section to move, then click and hold the mouse button.
   b. Drag the section to a new position in the Timecode Client.

      As the section is dragged, a red line previews the new location for the section.
   c. Release the mouse button to place the section at the selected location.

4. To remove a time source section from the Timecode Client, right click the section in the Timecode Client to remove and then select the Remove command from the Shortcut Menu.
5. To compress the size of the Timecode Client, right click the Timecode Client and select Compress View from the Shortcut Menu.

![Compressed View](image1)

Expanded View

In Compress View mode the Timecode Client only displays the highlighted timecode for each section.

6. To view other timecodes in a compressed section, click the section to rotate through the available timecodes.

7. To expand a compressed Timecode Client, right click the Timecode Client and select Expanded View from the Shortcut Menu.

For More Information on...
- how to position a BlackStorm Client in the Device View, refer to the chapter “BlackStorm Client Layout” on page 4–1.
Working with Playlists

The Playlist Client provides the controls to create and playout playlists. A playlist is a selection of custom-ordered media items that defines the following:

- The number of media items to playout
- The order of media item playout
- The portion of each media item to playout
- The method used to transition from the currently playing media item to the playout of the next media item.

You can open multiple playlist editors in the Playlist Client to create new playlists. For playout, the Playlist Client can open a playlist for each BlackStorm Server output channel. The Configuration Client contains the properties that set the video output GenLock for the Playlist Client.

This chapter discusses the following topics:

- Creating Playlists
- Editing Playlists
- Playing Out Playlists
Creating Playlists

You can use the Playlist Client to create and edit playlists on air or off-line. The BlackStorm Server treats playlists as media items.

A playlist can only contain media items from the same BlackStorm Server as the playlist.

To layout the Device View to work with playlists:

1. In the DashBoard Tree View, expand your BlackStorm Server node.

2. Expand the Channels node.
   The Channels node displays the available output channels.

3. Open an Output Channel for each playlist you want to create.

4. Expand the Control Applications node.
   The Control Applications node displays the available control applications.

5. Double-click the Media Manager node.
   The Media Manager opens in the Device View.

6. Double-click the Playlist Client node.
   The Playlist Client opens in the Device View.
7. Position the **Media Manager**, **Play Client**, and **Playlist Client** so that all clients are visible in the **Device View**.

With the Media Manager, Play, and Playlist Clients positioned in the Device View, the example work area is ready to create and use playlists.

**For More Information on...**

- how to position BlackStorm Clients in the Device View, refer to the chapter “**BlackStorm Client Layout**” on page 4–1.

**To create a playlist:**

1. In the **Playlist Client**, use the **File** menu to select **New Playlist**.

   The New Playlist dialog box opens.

2. In the **Playlist Name** box, enter a name for the new playlist.

   The Playlist Client supports the UTF-8 character set to enable the entry and display of international characters for playlist names.

   * Playlist names cannot contain the % (percent) character.
3. Select one of the following options to specify the editor in which to create a new playlist:

- **New Editor** — select this option to open a new **Playlist Editor** in which to create a new playlist. Use the Playlist Editor to create playlists off-line.

- **Channel 1** — select this option to create a new playlist on air in the **Channel 1** panel of the **Playlist Client**. This option enables the immediate playout of the new playlist on Channel 1, but disables editing the on air (red background) and next (green background) media items.

- **Channel 2** — select this option to create a new playlist on air in the **Channel 2** panel of the **Playlist Client**. This option enables the immediate playout of the new playlist on Channel 2, but disables editing the on air (red background) and next (green background) media items.

- **Channel 3** — select this option to create a new playlist on air in the **Channel 3** panel of the **Playlist Client**. This option enables the immediate playout of the new playlist on Channel 3, but disables editing the on air (red background) and next (green background) media items.

- **Channel 4** — select this option to create the new playlist on air in the **Channel 4** panel of the **Playlist Client**. This option enables the immediate playout of the new playlist on Channel 4, but disables editing the on air (red background) and next (green background) media items.

4. Click OK.

The **Media Manager** saves the new playlist as a media item. Depending on the selected playlist editor, the new playlist opens in either an **Editor** panel or the selected **Channel** panel.

5. Use the **Media Manager** to list the available media items that you can add to a playlist.
6. In the **Media Manager**, click and drag media items or playlists from the **Media Item** list into an open playlist **Editor** panel or **Channel** panel.

A playlist may contain a maximum of 300 media items. The Playlist Client automatically saves the playlist after each media item addition.

**A playlist can only contain media items encoded with the same video format and frame rate.**

After adding a Targa sequence media item to a playlist, the Playlist Client breaks the Targa sequence into individual Targa media items that construct the playlist. Changes made to the original Targa sequence media item do not affect the Targa media items added to the playlist.

When adding a playlist to another playlist, the Playlist Client only adds the individual media items in the selected playlist to the other playlist. Changes made to the original playlist do not affect the media items added to the other playlist.

---

**Editing Playlists**

You can use the Playlist Client to edit existing playlists as follows:

- Add media items to a playlist.
- Move media items in a playlist.
- Delete media items from a playlist.
- Set the portion of a media item to playout (in/out points).
- Set the action performed when a media item finishes playout.
- Set the method used to transition between media items.

You can use the Editor panel or a Channel panel in the Playlist Client to edit a playlist. The Editor panel enables off-line editing of a playlist. A Channel panel enables you to edit a playlist during playout, but disables editing the On Air (red) or Next (green) media items.

**The Playlist Client does not restrict multiple users from editing a playlist.**
To add a media item to a playlist:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or Channel panel of the Playlist Client.

   The Playlist Client displays the media items contained in the selected playlist.

2. Click and drag a media item from the Media Manager into the playlist open in an Editor panel or Channel panel.

   A playlist can only contain media items encoded with the same video format and frame rate. Also, playlists cannot contain a mixture of media items with alpha channels and no alpha channels.

3. Move the pointer to the position in the playlist to add the selected media item.

   A black bar indicates the selected playlist position for the new media item.
4. Release the mouse button to add the media item to the playlist at the selected position.

The playlist displays the added media item at the selected position, and the Playlist Client saves the updated playlist.

When adding a playlist to another playlist, the Playlist Client only adds the individual media items in the selected playlist to the other playlist. Changes made to the original playlist do not affect the media items added to the other playlist.

To move a media item in a playlist:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or Channel panel of the Playlist Client.

   The Playlist Client displays the media items contained in the selected playlist.

2. In the playlist, click and drag the media item to move.

3. Place the pointer in the playlist at the new position for the selected media item.

   A black bar indicates the new playlist position for the media item.

4. Release the mouse button to place the media item at the selected location in the playlist.

   The playlist displays the moved media item at the new location, and the Playlist Client saves the updated playlist.

To delete media items from a playlist:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or Channel panel of the Playlist Client.

   The Playlist Client displays the media items contained in the selected playlist.

2. In the playlist, right-click the media item to delete from the playlist and select Delete from the Shortcut menu.

   The Playlist Client deletes the selected media item from the playlist, but not from the BlackStorm Server.

   ✴ Deleting media items through the Media Manager or FTP are also removes the media items from any associated playlists.
To set the In Point and Out Point to play a portion of a media item:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or Channel panel of the Playlist Client.

   The Playlist Client displays the media items contained in the selected playlist.

2. In the playlist, double-click the media item to edit.

   The background color of the selected media item turns tan to indicate that the media item is in Edit mode.

   ![Image of Playlist Editor](image)

   The Channel panel cannot edit On Air (red) or Next (green) media items in a playlist.

3. In the In Point box, enter the timecode at which to start playing the media item.

   Enter timecodes as hours, minutes, seconds, and frames. The BlackStorm Server save entered timecodes with the playlist and do not affect individual media items when played outside of the playlist.

4. In the Out Point box, enter the timecode at which to stop playing the media item.

   When playing out a media item as part of the playlist, only the portion of the media item from the set In Point timecode to the set Out Point timecode plays out.

5. Press Enter to save timecode changes, or press ESC to discard the changes.

   The background color of the media item returns to the default color.

To set the action and transition performed when a media item finishes playout:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or Channel panel of the Playlist Client.

   The Playlist Client displays the media items contained in the selected playlist.

2. In the playlist, double-click the media item to edit.

   The background color of the selected media item turns tan to indicate that it is in Edit mode.
3. Use the **End Action** list to select the action to perform when playlist playout reaches the **Out Point** of the selected media item. The available actions are as follows:

- **X-Fade** — gradually transition playout from the playing media item to the next media item in the playlist. Use the list to the right to select the number of frames in which to complete the transition.
  
  This end action applies the set transition duration to the current and next media items in the playlist. For example: for a set duration of 30 frames, the transition uses 30 frames from each media item. The Playlist Client ignores this end action when the transition length is equal or longer than the current or next media item in the playlist.

- **V-Fade** — gradually transition playout from the playing media item to black and then gradually transition from black to the next media item in the playlist. Use the list to the right to select the number of frames in which to complete the transition.
  
  This end action applies half of the set transition duration to the current and next media items in the playlist. For example: for a set duration of 30 frames, the transition uses 15 frames from each media item. The Playlist Client ignores this end action when the transition length is equal or longer than the current or next media item in the playlist.

- **V-Fade with Pause** — pause playlist playout after gradually transition playout from the playing media item to black and then gradually transition from black to the next media item. Use the list to the right to select the number of frames in which to complete the transition.
  
  This end action applies half of the set transition duration to the current and next media items in the playlist. For example: for a set duration of 30 frames, the transition uses 15 frames from each media item. The Playlist Client ignores this end action when the transition length is equal or longer than the current or next media item in the playlist.

- **Play Next** — instantaneously switch playout from the playing media item to next media item in the playlist, or pause playout of the playlist.

- **Pause** — pause playlist playout.

- **Hold, Cue, Pause** — hold playout on the last frame of the current media item for a set number of frames, cue the next media item in the playlist, then pause the media item on the first frame of video. Use the list to the right to select the number of frames to hold on the last frame of the current media item. During the hold, the BlackStorm Server plays out the last frame of the current media item.
  
  When using this end action:
  
  - The set hold interval adds to the playlist length.
  - The set hold interval does not change the reported media item length.
  - For cued and paused media items, clicking **Step to next and Play** in the **Playlist Client** ignores the current media item end action and advances to the media item in the playlist.
  - This end action works when initiating a playlist from an external controller. The playlist continues after receiving the next play command from the external controller (AMP and VDCP).
  - If a **Play** command arrives from an external controller during the hold, it ends the hold and advances to the cued media item.
  - If a **Pause** command arrives from an external controller during the hold, use a **Continue** command to resume the hold for the remaining time. An **Advance** command cues and then pauses the media item.

  The Playlist Client automatically saves the selected end action with the playlist. End actions do not affect individual media items when played outside of a playlist.

- **When you change End Action span times, In Points, Out Points, or media item durations so that there is overlap in End Actions from one media item to another, may result in unexpected video changes during the overlap of End Action times.**

4. Press **Enter** to save action and transition changes, or press **ESC** to discard the changes.

  The background color of the media item returns to the default color.
Targa Duration

When you add a Targa file to a playlist, you can set the number of frames to keep the Targa file on a channel before playing out the next media item in the playlist.

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or Channel panel of the Playlist Client.

2. In the playlist, double-click the added Targa file to edit.

   The background color of the Targa file turns tan to indicate that the media item is in Edit mode.

When editing a playlist in a Channel panel, you cannot edit the On Air (red) and Next (green) media items.

3. In the Duration box, enter the number of frames to keep the Targa file on a channel before playing out the next media item in the playlist.

   When playing out individual Targa media items outside of the play list, the Targa durations saved with the playlist do not effect the playout.

4. Press Enter to save timecode changes, or press ESC to discard the changes.

   The Playlist Client converts the entered number of frames to a standard timecode (hours, minutes, seconds, and frames) and displays the timecode in the Out box and saves the set Targa duration with the playlist. The background color of the media item returns to the default color. The playlist duration is also updates to include the duration set for the Targa file.

Playing Out Playlists

You can playout playlists from the Media Manager, Play, or Playlist Client. To edit an on air playlist you must use the Playlist Client.

* When using a BlackStorm Server with the Ross Video OverDrive production automation system, the OverDrive operator must be aware of which playlists contains media items with an embedded Alpha Channel. OverDrive does not warn the operator that channels 3 or 4 is not available after loading channel 1 or 2 with a playlist that contains one or more media items with an embedded Alpha Channel.
To playout a playlist:

1. In DashBoard, position the Media Manager, Output Channels, and Playlist Client so that all clients are visible in the Device View. Refer to step 7 on page 7-3 for an example client layout.

2. In the Directory tab of the Media Manager, use the Filter list to select PlayLists.

   The icon displayed on a media item thumbnail indicates that the media item is a playlist.

   The icon displayed on a playlist thumbnail indicates that the playlist contains a media item with an embedded Alpha Channel. Playlists that contain media items with an embedded Alpha Channel require two channels for playout, one channel for the video and another channel for the alpha.

   ![Image: System Video Channel Alpha Channel]

<table>
<thead>
<tr>
<th>System</th>
<th>Video Channel</th>
<th>Alpha Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Channel</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>4 Channel</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>4</td>
</tr>
</tbody>
</table>

   The BlackStorm Server reserves Alpha Channels for the full duration of a playlist. The Play Client opened for the Alpha Channel displays the message Channel: Alpha.

3. Double-click the icon to view the media items contained in the selected playlist.

   The selected media item expands to display the media items contained in the playlist and the icon changes to .

   Double-click the icon to collapse the playlist to a single item.

4. Use one of the following methods to load a playlist into a channel.
   - Drag a media item from the Media Manager to a Channel panel in the Playlist Client.
   - Use the File > Load/Edit Playlist command from the Playlist Client to open a playlist in a Channel panel.
   - Use the Media Manager to select a media item and to load it into a channel.
   - Drag a media item from the Media Manager to an open Output Channel.

   The link and key icons indicate that a playlist loaded in a Channel Panel or Playlist Editor contains a media item with an embedded Alpha Channel.

   ![Image: Link Icon Key Icon]

   ![Image: Playlist with Alpha in a Channel Panel]

   ![Image: Playlist with Alpha in a Playlist Editor]

5. Use one of the following methods to start playout of the loaded playlist.
   - In the Media Manager, click Play in the channel that contains the loaded playlist.
   - In the Output Channel panel that contains the loaded playlist, click Play.
   - In the Playlist Client, right-click the first media item in the loaded playlist and select Play Now from the Shortcut menu.
The first media item in the playlist starts playing out on the loaded channel of the BlackStorm Server. The Playlist Client shades the background of the on air media item is red and the background of the next media item to go on air green.

6. To cue a playlist to a selected media item in the playlist, right-click a media item and select **Cue Now** from the **Shortcut** menu.

The playlist cues to the selected media item. To start playout from the cued media item, click **Play** in the **Media Manager** or **Play Client** channel that contains the loaded playlist.

7. To start playout of a selected media item in the playlist, right-click a media item and select **Play Now** from the **Shortcut** menu.

Playout of the playlist continues from the selected media item.

8. To select a media item as the next media item to play, right-click a media item and select **Set to Play Next** from the **Shortcut** menu.

After playout of the currently playing media item finishes, playout of the playlist continues with the selected media item.

9. Select the **Show “On Air” and “Next” clip** command from the **View** menu to toggle the display of the on air and next media items around the **Playlist Controls**.

10. During playout, the **Playlist** section automatically scrolls to display the on air media item at the top of the section.

Use the Playlist section scroll bar to view media items that are not visible in the Playlist section. Automatic scrolling of the Playlist section stops when the on air and next media items are not visible the section.

11. To view the on air media item in the **Playlist** section, click **Jump to Live** in the **Playlist Controls** to scroll the on air media item to the top of the Playlist section and resume automatic scrolling of the section.
To control a playlist during playout:

1. Use any of the controls in an Output Channel panel to control playout of the loaded playlist.

2. Each Channel panel in the Playout Client contains the following playlist controls:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Step to Next and Play" /></td>
<td><strong>Step to Next and Play</strong> — click this button to put the next media item in the playlist on air and start media item playout.</td>
</tr>
<tr>
<td><img src="image" alt="Step to Next" /></td>
<td><strong>Step to Next</strong> — click this button to put the next media item in the playlist on air. This button does not start media item playout.</td>
</tr>
<tr>
<td><img src="image" alt="Eject" /></td>
<td><strong>Eject</strong> — click this button to eject the playlist from the current channel.</td>
</tr>
<tr>
<td><img src="image" alt="Jump to Live" /></td>
<td><strong>Jump to Live</strong> — click this button to scroll the on air media item to the top of the Playlist section and resume automatic scrolling of the section.</td>
</tr>
</tbody>
</table>

3. You can edit all but the on air and next media items during playlist playout. You can use a Channel panel in the Playlist Client to perform the following edits to a playlist during playout:

   - “To add a media item to a playlist:” on page 7–6
   - “To move a media item in a playlist:” on page 7–7
   - “To delete media items from a playlist:” on page 7–7
   - “To set the In Point and Out Point to play a portion of a media item:” on page 7–8
   - “To set the action and transition performed when a media item finishes playout:” on page 7–8

For More Information on...

- Output Channel controls, refer to the section “Playing Media Items” on page 6–2.
- how to playout playlists that contain media items with an Alpha Channel, refer to the section “Playing Media Items that Contain an Embedded Alpha Channel” on page 6–6.
- how to edit playlists, refer to the section “Editing Playlists” on page 7–5.
- how to delete playlists, refer to the procedure “To delete media items from a playlist:” on page 7–7
Coloring BlackStorm Clients

You can use the Color Chooser dialog box to independently change the background and the text color for each open Media Manager, Play, or Playlist Client. When using multiple channels on a BlackStorm Server, identifying each channel with a different color can be very helpful in enabling an operator to quickly differentiate between channels and clients. For example, you can select red for channel 1, green for channel 2, yellow for the Media Manager, and blue for the Playlist Client.

This chapter discusses the following topics:

- Client Background and Text Colors
- Customizing Colors
Client Background and Text Colors

You can independently change the background and the text color used to label the sections and tabs in any open Media Manager, Play, or Playlist Client.

To change the background and the text color of an open BlackStorm Client:

1. In an open Media Manager, Play Client, or Playlist Client select one of the following commands from the View menu:
   - Background Color — change the background color of a client.
   - Foreground Color — change the text color of a client.
   The Color Chooser dialog box associated with the selected command opens.

2. In the Swatches tab, click the square that contains the color to use for the background or text. Click the Reset button to return to the default color.

3. Use the Preview section to view an example of the selected color scheme.

4. Click OK to apply the selected color and close the Choose Color dialog box.

Customizing Colors

In addition to the predefined colors on the Swatch tab in the Choose Color dialog boxes, it is also possible to define custom colors using one of the following methods:

- HSB — Hue, Saturation, and Brightness
- RGB — Red, Green, Blue

Defining a Color Using HSB

Use HSB values as follows to define a color:

- **Hue** — the location of a color in the spectrum. The six basic divisions of the hue spectrum are: red, yellow, blue, orange, green, and purple.
- **Saturation** — the intensity of a color within the spectrum. The less gray in a color, the more saturated it appears.
- **Brightness** — the intensity which light reflects from or transmits through a color.
To use HSB values to define a custom background or text color:

1. In an open Media Manager, Play Client, or Playlist Client, select one of the following commands from the View menu:
   - **Background Color** — change the background color of a client.
   - **Foreground Color** — change the text color of a client.
   
   The Color Chooser dialog box associated with the selected command opens.

2. Click the HSB tab.

   The HSB tab opens.

3. Select the **H** option, then set the hue for the new color using one of the following methods:
   - Drag the slider up or down the hue scale.
   - Enter or select a hue value in the box to the right of the **H** option.

4. Select the **S** option, then set the saturation for the new color using one of the following methods:
   - Drag the slider up or down the saturation scale.
   - Enter or select a saturation value in the box to the right of the **S** option.

5. Select the **B** option, then adjust the brightness of the new color using one of the following methods:
   - Drag the slider up or down the brightness scale.
   - Enter or select a brightness value in the box to the right of the **B** option.

6. Use the Preview section to view an example of the selected color scheme.

7. Click **OK** to apply the new color and close the Choose Color dialog box.

   After setting a hue, saturation, or brightness value, select the new color from the **Color Square**. The selected point in the **Color Square** sets the remaining values for the new color.

**Defining a Color Using RGB**

Use RGB values as follows to define a color:

- **Red** — the level of red in the defined color.
- **Green** — the level of green in the defined color.
- **Blue** — the level of blue in the defined color.
To use RGB values to define a custom background or text color:

1. In an open Media Manager, Play Client, or Playlist Client, select one of the following commands from the View menu:
   • Background Color — change the background color of a client.
   • Foreground Color — change the text color of a client.
   The Color Chooser dialog box associated with the selected command opens.

2. Click the RGB tab.
   The RGB tab opens.

3. Set the level of red in the new color using one of the following methods:
   • Drag the slider along Red scale. The box the right of the Red scale displays the set red level value.
   • Enter or select a value for the red level in the box to the right of the Red scale.

4. Set the level of green in the new color using one of the following methods:
   • Drag the slider along Green scale. The box the right of the Green scale displays the set green level value.
   • Enter or select a value for the green level in the box to the right of the Green scale.

5. Set the level of blue in the new color using one of the following methods:
   • Drag the slider along Blue scale. The box the right of the Blue scale displays the set blue level value.
   • Enter or select a value for the blue level in the box to the right of the Blue scale.

6. Use the Preview section to view an example of the selected color scheme.

7. Click OK to apply the new color and close the Choose Color dialog box.
Appendix A. Specifications

This appendix describes basic properties of the BlackStorm Server, including specifications, capabilities, and specific conventions to follow when using the BlackStorm Server.

This appendix discusses the following topics:

• Media Formats and Codecs
• VDCP Commands for the BlackStorm Server
• AMP Commands for the BlackStorm Server
• Communication Serial Port
Media Formats and Codecs

The BlackStorm Server supports the following media formats and codecs for playout.

Media File Formats

The BlackStorm Server supports the following video media formats:

- **QuickTime files (.MOV)** — a BlackStorm server can directly play QuickTime Standard Definition (SD) and High Definition (HD) media items that use the QuickTime Animation or the DV family of codecs.

  * Stutter may occur when the BlackStorm Server RAID controller goes into Patrol Read state during the playout of high bit rate, greater than 600 Mb/sec, QuickTime Animation RLE encoded video files. Patrol Read is a disk drive consistency check that verifies the virtual disk drives for physical disk errors that could lead to drive failures. Patrol Read is a scheduled task that you can disable in extreme conditions. If you do disable Patrol Read, please schedule a time to run the Patrol Read during non-peak times. Use the Dell SAS RAID Storage Manager on the BlackStorm Server to modify the Patrol Read settings.

- **Avid DNxHD®** — a BlackStorm Server supports media files encoded with the Avid® Digital Nonlinear Extensible High Definition codec at the following bit rates:
  - 145 Mb/sec, 8-bit depth
  - 220 Mb/sec, 8-bit depth

  * When you render Avid DNxHD® media clips for playout on a BlackStorm Video Server at 720p50, you must render the media clips at 50fps. Rendering Avid DNxHD® media clips at other frame rates can cause incorrect video playout speed from a BlackStorm Video Server.

- **Uncompressed Targa files (.TGA)** — a BlackStorm server can directly play 24 and 32 bit Targa files.

- **Run Length Encoded Targa files (.TGA)** — a BlackStorm server can directly play 24 and 32 bit Targa files.

  * When importing Targa files, note the current BlackStorm video format and the frame rate. Targa media items are only available for playout when the BlackStorm Server is running in the same format and the frame rate as it was at time of Targa file import.

The BlackStorm Server supports the following audio media formats:

- **Interleaved** — 48 KHz x 16, 24, or 32 bit audio inteleaved in a video file.

<table>
<thead>
<tr>
<th>Codec</th>
<th>Format</th>
<th>Bitrate</th>
<th>Approximate Hours / TB</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV, DVCAM, DVC PRO</td>
<td>SD</td>
<td>25 Mb/sec</td>
<td>82</td>
</tr>
<tr>
<td>DVCPRO 50</td>
<td>SD</td>
<td>50 Mb/sec</td>
<td>43</td>
</tr>
<tr>
<td>QUICKTIME ANIMATION</td>
<td>SD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVCPRO HD</td>
<td>HD</td>
<td>100 Mb/sec</td>
<td>22</td>
</tr>
<tr>
<td>QUICKTIME ANIMATION</td>
<td>HD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>HD</td>
<td>145 Mb/sec</td>
<td>16</td>
</tr>
<tr>
<td>DNxHD 220</td>
<td>HD</td>
<td>220 Mb/sec</td>
<td>10</td>
</tr>
</tbody>
</table>
VDCP Commands for the BlackStorm Server

The Video Disk Communications Protocol (VDCP) is a tightly-coupled master/slave communication method based on the RS-422 signal standards. The controlling device initiates communication between itself and the controlled device. This protocol also conforms to the Open Systems Interconnect (OSI) reference model.

The BlackStorm Server responds to the following commands under VDCP control:

**Table 9.2 Supported VDCP Commands**

<table>
<thead>
<tr>
<th>CMD-1</th>
<th>CMD-2</th>
<th>Name</th>
<th>CMD-1</th>
<th>CMD-2</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1X</td>
<td>00</td>
<td>Stop</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>1X</td>
<td>01</td>
<td>Play</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>1X</td>
<td>04</td>
<td>Still</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>1X</td>
<td>05</td>
<td>Step</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>1X</td>
<td>06</td>
<td>Continue</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>1X</td>
<td>07</td>
<td>Jog</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>1X</td>
<td>08</td>
<td>Variable Play</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>2X / AX</td>
<td>21</td>
<td>Close Port</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>2X</td>
<td>22</td>
<td>Select Port</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>2X / AX</td>
<td>24</td>
<td>Play Cue</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>2X / AX</td>
<td>25</td>
<td>Cue with Data</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>2X / AX</td>
<td>26</td>
<td>Delete ID</td>
<td>04</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>3X</td>
<td>01</td>
<td>Open Port</td>
<td>3X</td>
<td>81</td>
<td>Grant/Denied</td>
</tr>
<tr>
<td>3X / BX</td>
<td>02</td>
<td>Next</td>
<td>3X</td>
<td>82</td>
<td>List of IDs</td>
</tr>
<tr>
<td>3X / BX</td>
<td>03</td>
<td>Last</td>
<td>3X</td>
<td>83</td>
<td>Last Response</td>
</tr>
<tr>
<td>3X</td>
<td>05</td>
<td>Port Status Request</td>
<td>3X</td>
<td>85</td>
<td>State Status</td>
</tr>
<tr>
<td>3X</td>
<td>06</td>
<td>Position Request</td>
<td>3X</td>
<td>86</td>
<td>Position</td>
</tr>
<tr>
<td>3X / BX</td>
<td>07</td>
<td>Active ID Request</td>
<td>3X</td>
<td>87</td>
<td>Active ID</td>
</tr>
<tr>
<td>3X</td>
<td>08</td>
<td>Device Type Request</td>
<td>3X</td>
<td>88</td>
<td>Device Type</td>
</tr>
<tr>
<td>3X</td>
<td>10</td>
<td>System Status Request</td>
<td>3X</td>
<td>90</td>
<td>System Status</td>
</tr>
<tr>
<td>3X / BX</td>
<td>11</td>
<td>ID List</td>
<td>3X</td>
<td>91</td>
<td>List of IDs</td>
</tr>
<tr>
<td>3X / BX</td>
<td>14</td>
<td>ID Size Request</td>
<td>3X</td>
<td>94</td>
<td>ID Size</td>
</tr>
<tr>
<td>3X / BX</td>
<td>15</td>
<td>IDs Added to Arch.</td>
<td>3X</td>
<td>95</td>
<td>List IDs Trans.</td>
</tr>
<tr>
<td>3X / BX</td>
<td>16</td>
<td>ID Request</td>
<td>3X</td>
<td>96</td>
<td>ID Presence</td>
</tr>
<tr>
<td>3X / BX</td>
<td>18</td>
<td>IDs Added List</td>
<td>3X</td>
<td>98</td>
<td>List IDs Added</td>
</tr>
<tr>
<td>3X / BX</td>
<td>19</td>
<td>IDs Deleted List</td>
<td>3X</td>
<td>99</td>
<td>List IDs Deleted</td>
</tr>
</tbody>
</table>
AMP Commands for the BlackStorm Server

The Advanced Media Protocol (AMP) is a set of commands used to control video equipment. Odetics Broadcast Corporation defined the initial set of AMP commands in the document *Video Disk Recorder Command and Control Specification*. Grass Valley has extended existing commands and added new commands to the protocol.

The BlackStorm Server responds to the following commands under AMP control:

**Table 9.3 Supported AMP Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Name</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X.00</td>
<td>Stop</td>
<td>ACK</td>
</tr>
<tr>
<td>2X.01</td>
<td>Play</td>
<td>ACK</td>
</tr>
<tr>
<td>20.0F</td>
<td>Eject</td>
<td>ACK</td>
</tr>
<tr>
<td>20.10</td>
<td>Fast Forward</td>
<td>ACK</td>
</tr>
<tr>
<td>2X.11</td>
<td>Jog Forward</td>
<td>ACK</td>
</tr>
<tr>
<td>2X.12</td>
<td>Variable Forward</td>
<td>ACK</td>
</tr>
<tr>
<td>20.20</td>
<td>Rewind</td>
<td>ACK</td>
</tr>
<tr>
<td>2X.21</td>
<td>Jog Reverse</td>
<td>ACK</td>
</tr>
<tr>
<td>2X.22</td>
<td>Variable Reverse</td>
<td>ACK</td>
</tr>
<tr>
<td>40.40</td>
<td>Auto Mode Off</td>
<td>ACK</td>
</tr>
<tr>
<td>40.41</td>
<td>Auto Mode On</td>
<td>ACK</td>
</tr>
<tr>
<td>4X.14</td>
<td>In Preset</td>
<td>ACK</td>
</tr>
<tr>
<td>4X.15</td>
<td>Out Preset</td>
<td>ACK</td>
</tr>
<tr>
<td>40.20</td>
<td>In Reset</td>
<td>ACK</td>
</tr>
<tr>
<td>4X.21</td>
<td>Out Reset</td>
<td>ACK</td>
</tr>
<tr>
<td>41.42</td>
<td>Set Loop Playback Mode</td>
<td>ACK</td>
</tr>
<tr>
<td>61.0C</td>
<td>Current Time Sense</td>
<td>ACK</td>
</tr>
<tr>
<td>61.20</td>
<td>Status Sense</td>
<td>ACK</td>
</tr>
<tr>
<td>A0.06</td>
<td>Preview In Reset</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.07</td>
<td>Preview Out Reset</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.05</td>
<td>Preview Out Preset</td>
<td>ACK</td>
</tr>
<tr>
<td>A0.16</td>
<td>ID Loaded Request</td>
<td>ACK</td>
</tr>
<tr>
<td>A0.26</td>
<td>ID Count Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.14</td>
<td>List First ID</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.15</td>
<td>List Next ID</td>
<td>ACK</td>
</tr>
<tr>
<td>0X.06</td>
<td>Set Drop Frame Mode</td>
<td>ACK</td>
</tr>
<tr>
<td>0X.11</td>
<td>Device Type Request</td>
<td>ACK</td>
</tr>
<tr>
<td>4X.31</td>
<td>Pre Roll</td>
<td>ACK</td>
</tr>
<tr>
<td>4X.45</td>
<td>Get Stop Mode</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.04</td>
<td>Preview In Preset</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.0E</td>
<td>Set Working Folder Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.0F</td>
<td>Get Working Folder Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.10</td>
<td>Erase Id</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.13</td>
<td>Clip Data Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.14</td>
<td>First ID</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.15</td>
<td>Next ID</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.17</td>
<td>ID Duration</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.18</td>
<td>ID Status Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.21</td>
<td>Device Id Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.25</td>
<td>Id Start Time Request</td>
<td>ACK</td>
</tr>
<tr>
<td>AX.2C</td>
<td>Device Name Request</td>
<td>ACK</td>
</tr>
</tbody>
</table>

The behavior of the List First Folder (AX.2A), List Next Folder (AX.2B), First ID (AX.14), and the Next ID (AX.15) commands change after the BlackStorm Server receives the Set Working Folder Request (AX.0E) command. By default the BlackStorm Server treats the media file system as a single directory that contains all of the media items on a server. With only one directory to manage, the switcher only uses the First ID (AX.14) and Next ID (AX.15) commands to retrieve all of the clips on the server.

After the BlackStorm Server receives the Set Working Folder Request (AX.0E) command, the server sees the contents and sub-directories in the media directory as they actually are on the server hard drive. Use the List First Folder (AX.2A) and List Next Folder (AX.2B) commands to navigate the sub-directories within the media directory. Use the First ID (AX.14) and Next ID (AX.15) commands to retrieve the clips in the working directory.

There is no AMP command to switch the BlackStorm Server back to viewing the media directory as a single directory. After sending the Set Working Folder Request (AX.0E) command to the BlackStorm Server, you must restart the server to once again view the media directory as a single directory.
Communication Serial Port

The pinouts for the serial communication ports (Com3 and Com4) in the breakout cable attached to the rear of a BlackStorm Server are as follows:

![Diagram of RS-422 Serial Communication Port](image)

**Figure 9.1 BlackStorm Server RS-422 Male DB9 Serial Communication Port (Com 3 and Com 4)**

**Table 9.4 BlackStorm Server Serial Communication Port Pinouts**

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>RxD-</td>
</tr>
<tr>
<td>3</td>
<td>TxD+</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Not Connected</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxD+</td>
</tr>
<tr>
<td>8</td>
<td>TxD-</td>
</tr>
<tr>
<td>7</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Use the following information to create an RS-422 serial interface cable (Male DB9 to Male DB9) to connect a Ross Video switcher to BlackStorm Server.

![Diagram of RS-422 Serial Communication Cable Connectors](image)

**Figure 9.2 RS-422 DB9 Serial Communication Cable Connectors**

**Table 9.5 RS-422 DB9 Serial Communication Cable Pinouts**

<table>
<thead>
<tr>
<th>To Switcher Signal</th>
<th>Pin #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Connected</td>
<td>1</td>
</tr>
<tr>
<td>RxD-</td>
<td>2</td>
</tr>
<tr>
<td>TxD+</td>
<td>3</td>
</tr>
<tr>
<td>Not Connected</td>
<td>4</td>
</tr>
<tr>
<td>Ground</td>
<td>5</td>
</tr>
<tr>
<td>Not Connected</td>
<td>6</td>
</tr>
<tr>
<td>RxD+</td>
<td>7</td>
</tr>
<tr>
<td>TxD-</td>
<td>8</td>
</tr>
<tr>
<td>Not Connected</td>
<td>7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To BlackStorm Server Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>TxD-</td>
</tr>
<tr>
<td>7</td>
<td>RxD+</td>
</tr>
<tr>
<td>1, 4, 6, 9</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>TxD+</td>
</tr>
<tr>
<td>2</td>
<td>RxD-</td>
</tr>
</tbody>
</table>
Appendix B.
Configuration File Settings

The BlackStorm Server Configuration Client does not contain all available BlackStorm Server configuration settings. To configure obscure BlackStorm settings, you must edit a configuration file using a text editor. This appendix describes how to set the BlackStorm Server configuration settings that are not available in the Configuration Client.

This appendix discusses the following topics:

- Editing Configuration Files
- Client Settings Set by Editing a Configuration File
- Server Settings Set by Editing Configuration Files
- Crispin NewsCat Settings
- Horizontal and Vertical Video Offset Settings
Editing Configuration Files

BlackStorm Servers store configuration settings in a series of XML formatted text files.

To edit BlackStorm Server configuration files:

1. Use the following credentials to log on to the BlackStorm Server as the default user:
   - User name — blackstorm
   - Password — blackstorm

2. Navigate to the C:\Ross\BlackStorm folder. This folder includes the following configuration files that contain configuration settings that may require editing:
   - "BoardSettings.xml" on page 10–3
   - "defaultSettings.properties" on page 10–2
   - "FTPCConfig.xml" on page 10–3
   - "MediaFolders.xml" on page 10–4
   - "ServerSettings.xml" on page 10–4

3. Before editing a configuration file, make a copy of the configuration file. You can use the copy of a configuration file to restore a broken configuration file.

4. Use a text editor to open and edit the configuration file that contains the settings to change. For descriptions of the available configuration settings, refer to the sections in this chapter.

5. Save the updated configuration file.
6. Restart the BlackStorm Server computer.

Client Settings Set by Editing a Configuration File

To configure obscure BlackStorm client settings, you must edit the defaultSettings.properties configuration file with a text editor.

defaultSettings.properties

Each BlackStormServer DashBoard client computer contains a defaultSettings.properties file in the following folder:

- C:\DashBoard\workspace\.metadata\.plugins\com.rossvideo.softmetal.rice\conf

Since DashBoard is a client side application, you must make setting changes to the defaultSettings.properties files on each DashBoard client computer connected to your BlackStorm Server.

This file contains the following settings:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>defaultNewECAType</td>
<td>None</td>
<td>N/A</td>
<td>The default playlist End of Clip Action (ECA) to use when adding multiple clips to a playlist. Available values are xfade, vfade, vfadepause, next, pause, or holdcuepause.</td>
</tr>
<tr>
<td>defaultNewECAParam</td>
<td>None</td>
<td>Frames</td>
<td>The default duration to apply to each ECA.</td>
</tr>
</tbody>
</table>
Server Settings Set by Editing Configuration Files

To configure obscure BlackStorm Server settings, you must edit configuration files with a text editor. This section describes the BlackStorm Server configuration settings that you set by editing configuration files with a text editor.

BoardSettings.xml

This file contains the following settings:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
<th>Unit</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>m_HorizontalOffset</td>
<td>5000</td>
<td>pixels</td>
<td>The number of pixels that the BlackStorm Server applies to the video signal horizontal offset. The valid range is -2048 to +2048 pixels. Enter a value of 5000 pixels for no horizontal adjustment. Use the AJA Xena Control Panel to adjust this setting in real-time.</td>
</tr>
<tr>
<td>m_VerticalOffset</td>
<td>5000</td>
<td>pixels</td>
<td>The number of pixels that the BlackStorm Server applies to the video signal vertical offset. The valid range is -1024 to +1024 pixels. Enter a value of 5000 pixels for no vertical adjustment. Use the AJA Xena Control Panel to adjust this setting in real-time.</td>
</tr>
</tbody>
</table>

For More Information on...

• setting video offsets in real-time, refer to the section “Horizontal and Vertical Video Offset Settings” on page 10–6.

FTPConfig.xml

This file contains the following settings:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>m_nDataPort</td>
<td>50024</td>
<td></td>
<td>The base port number used with the m_nMumDataPorts setting to define a range of TCP ports allowed by your network administrator for transfer of FTP data.</td>
</tr>
<tr>
<td>m_nNumDataPorts</td>
<td>10</td>
<td>N/A</td>
<td>Use this setting with the m_nDataPort setting to specify a range of FTP ports for data transmission.</td>
</tr>
<tr>
<td>m_nControlPort</td>
<td>21</td>
<td></td>
<td>The TCP port number used by FTP clients to communicate with the BlackStorm Server FTP service.</td>
</tr>
<tr>
<td>m_strBoundIp</td>
<td>None</td>
<td>N/A</td>
<td>The IPv4 string, assigned to a local BlackStorm Server NIC, that identifies the NIC to use for FTP communication.</td>
</tr>
<tr>
<td>m_strUser</td>
<td>blackstorm</td>
<td>N/A</td>
<td>The username used to access to the BlackStorm Server FTP service. The BlackStorm Server FTP service always allows the username “blackstorm”, even if this setting uses a different username.</td>
</tr>
</tbody>
</table>
### MediaFolders.xml

This file contains the following settings:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>m_dropFolder</td>
<td>D:\Drop</td>
<td>N/A</td>
<td>The folder in which you place media files for the BlackStorm Server to import as media items into the database and the Target folder. Use the m_targetFolder setting to set the Target folder.</td>
</tr>
<tr>
<td>m_targetFolder</td>
<td>D:\Media</td>
<td>N/A</td>
<td>The folder to which the BlackStorm Server imports media files as media items from the Drop folder. Use the m_dropFolder setting to set the Drop folder.</td>
</tr>
<tr>
<td>m_rootFolder</td>
<td>D:\Media</td>
<td>N/A</td>
<td>The absolute Windows pathname of the FTP root folder.</td>
</tr>
</tbody>
</table>

### ServerSettings.xml

This file contains the following settings:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>playlist_cap</td>
<td>300</td>
<td>N/A</td>
<td>The maximum number of clips that you can add to a playlist. Increasing the value of this setting adversely affects the performance of the BlackStorm Server and Playlist Client when working with playlists.</td>
</tr>
</tbody>
</table>
ControllerPortsConfig.xml

This file contains the following settings:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Default Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>m_useFileExtensionsAMP</td>
<td>false</td>
<td>N/A</td>
<td><strong>True</strong>: add file extensions to clip IDs sent by AMP commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>False</strong>: do not add file extensions to clip IDs sent by AMP commands.</td>
</tr>
<tr>
<td>m_useFileExtensionsVDCP</td>
<td>false</td>
<td>N/A</td>
<td><strong>True</strong>: add file extensions to clip IDs sent by VDCP commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>False</strong>: do not add file extensions to clip IDs sent by VDCP commands.</td>
</tr>
<tr>
<td>m_useAmpWorkingFolders</td>
<td>true</td>
<td>N/A</td>
<td><strong>True</strong>: send ACK for the AMP commands: GetFirstFolder, GetNextFolder,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GetWorkingFolder, and SetWorkingFolder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>False</strong>: send NACK for the AMP commands GetFirstFolder, GetNextFolder,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GetWorkingFolder, and SetWorkingFolder.</td>
</tr>
<tr>
<td>m_useAmpFlatFolderList</td>
<td>false</td>
<td>N/A</td>
<td><strong>True</strong>: generate a list of folder names relative to the current working</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>folder. Do not include the folder path with the folder name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>False</strong>: generate a list of folder names from the root of the watch</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>folders. Include the folder path with the folder name.</td>
</tr>
</tbody>
</table>

Crispin NewsCat Settings

When using Crispin NewsCat to control a BlackStorm Server, you must configure the server to add file extensions to clip IDs sent by AMP or VDCP commands. The m_useFileExtensionsAMP configuration setting controls whether or not to add file extensions to clip IDs.

**To add file extensions to clip IDs:**

1. Use the following credentials to log on to the BlackStorm Server as the default user:
   - **User name** — blackstorm
   - **Password** — blackstorm
2. Navigate to the C:\Ross\BlackStorm folder.
3. Use a text editor to open and edit the ControllerPortsConfig.xml file.
4. In the ControllerPortsConfig.xml file, locate the following line of text:
   <m_useFileExtensionsAMP type="bool">false</m_useFileExtensionsAMP>
5. Replace the word **false** with **true**.
6. Locate the following line of text:
   <m_useFileExtensionsVDCP type="bool">false</m_useFileExtensionsVDCP>
7. Replace the word **false** with **true**.
8. Save the updated ControllerPortsConfig.xml file.
9. Restart the BlackStorm Server computer.
Horizontal and Vertical Video Offset Settings

On a running BlackStorm Server, you can use the AJA Xena Control Panel to set the vertical and horizontal offset values that the BlackStorm Server applies to the output video signal.

To set video signal horizontal and vertical offset:

1. On the BlackStorm Server, start playing out a media item.
2. On the BlackStorm Server computer, start the following application:
   • C:\Program Files(x86)\AJA\Xena\SDK\DiagnosticsAndTools\XenaControlPanel
   The XenaControlPanel icon opens to the System Tray.

3. In the System Tray, click the XenaControlPanel icon and select Settings from the menu.
   The Settings tab opens in the Control Panel for Corvid 22 or 24 dialog box.

4. Use the Vertical Offset box to enter or select the number of pixels that the BlackStorm Server applies to the video signal vertical offset.
   The valid range is -1024 to +1024 pixels. Enter a value of 0 pixels for no horizontal adjustment.

5. Use the Horizontal Offset box to enter or select the number of pixels that the BlackStorm Server applies to the video signal vertical offset.
   The valid range is -2048 to +2048 pixels. Enter a value of 0 pixels for no horizontal adjustment.

6. Click Apply.

7. Use the playing media item to verify that the new offset values are correct.

8. After setting the correct offset values, close Control Panel for Corvid 22 or 24 dialog box.
Index

A
Alpha Channel ................................................ 6-6
AMP
commands ..................................................... 9-4
Ancillary Time Code (ATC) ......................... 3-13
Audio Format.................................................. 9-2

B
Background Color
blue level...................................................... 8-4
brightness ..................................................... 8-3
green level.................................................... 8-4
hue................................................................ 8-3
red level........................................................ 8-4
saturation...................................................... 8-3
Browse
import folder ................................................ 5-8
Buckets............................................................ 6-7
adding media items ...................................... 6-9
creating......................................................... 6-8
deleting....................................................... 6-10
deleting media items .................................... 6-9
loading channels......................................... 6-11
renaming .................................................... 6-10

C
Channels
loading.......................................................... 6-5
loading from buckets................................. 6-11
naming.......................................................... 3-8
Client Software
installation.................................................... 2-3
update ........................................................... 2-9
usage .............................................................. 2-2
Clients
Configuration ............................................... 3-1
Media Manager ............................................ 5-3
moving .......................................................... 4-5
opening ......................................................... 4-2
Play ............................................................. 6-12, 6-13
Playlist.......................................................... 7-1
resizing ........................................................ 4-8
Timecode....................................................... 6-17

Codecs ............................................................. 9-2
Color Chooser
background color .......................................... 8-2
blue level...................................................... 8-4
brightness.................................................... 8-3
foreground color ........................................... 8-2
green level.................................................... 8-4
hue................................................................. 8-3
opening ........................................................ 8-2
red level....................................................... 8-4
saturation ...................................................... 8-3
Configuration Client
opening ....................................................... 3-5
tabs
Channel Name ............................................. 3-8
Channel Time............................................. 3-13
GenLock ..................................................... 3-9
House Time................................................ 3-12
Remote Control.......................................... 3-10
Configuration File
Settings ....................................................... 10-1
Configuring
information logs............................................. 3-7
output resolution......................................... 3-9
Connections
network ......................................................... 3-2
status ............................................................. 4-2
Controllers
Crispin NewsCat........................................... 10-5
Creating
buckets.......................................................... 6-8
playlist .......................................................... 7-2
Cueing
media items .................................................... 6-15

D
DashBoard ....................................................... 2-4
additional windows...................................... 4-10
configure for clients.................................... 2-4
opening ......................................................... 3-5
Database
Service ....................................................... 2-19
Deleting
buckets........................................................ 6-10
media item .................................................... 5-4
media items from buckets.............................. 6-9
P
Picon
generation................................................... 6-14
media item.................................................. 6-13
Play Client
media item picon........................................ 6-13
playout controls........................................ 6-13
Playlist
add media item............................................. 7-6
alpha channel ............................................. 7-11
client............................................................. 7-4
create........................................................... 7-2
creating....................................................... 7-3
delete media item ......................................... 7-7
editing .......................................................... 7-5
end action and transition .............................. 7-8
playout........................................................ 7-10
re-order......................................................... 7-7
trim points.................................................... 7-8
Playout
advanced .................................................... 6-12
loop ............................................................ 6-16
one frame at a time..................................... 6-16
playlist........................................................ 7-10
portion of a media item .............................. 6-15
Playout Controls
Media Manager .....................................6-5, 6-7
Play Client.................................................. 6-13
Q
QuickTime ...................................................... 9-2
R
RGB Levels
blue............................................................... 8-4
green............................................................. 8-4
red ................................................................ 8-4
S
Selecting
background color ........................................ 8-2
foreground color ........................................... 8-2
media items .................................................. 6-5
output channel ............................................. 6-3
Server
software uninstall....................................... 2-18
software update ........................................... 2-11
Services....................................................... 2-19
Start........................................................... 2-20
Stop............................................................ 2-20
Settings
firewall....................................................... 3-4
network ....................................................... 3-5
Software
client update............................................... 2-9
install clients.............................................. 2-8
installing clients......................................... 2-3
server uninstall......................................... 2-18
server update............................................ 2-11
uninstall.................................................... 2-18
System Requirements
hardware .................................................... 2-2
software ..................................................... 2-3
T
Tabs
Buckets....................................................... 6-8
Channel Name............................................ 3-8
Channel Time.............................................. 3-13
Directory..................................................... 6-3
GenLock ...................................................... 3-9
House Time............................................... 3-12
Remote Control....................................... 3-10
Targa ............................................................ 9-2
duration....................................................... 7-10
Technical Support..................................... 1-3
Timecode Client .......................................... 6-17
Trimpoints
video ........................................................... 6-15
U
Uninstalling
client software............................................ 2-18
server software......................................... 2-18
Updating
client software........................................... 2-9
UTF-8 .......................................................... 1-1
V
VDCP
commands.................................................. 9-3
port mapping............................................... 3-11
protocol..................................................... 3-10
Vertical Video Offset..................................... 10-6
Video Offset .................................................. 10-6

W
Wizard
Media Import............................................. 5-7